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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions.
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Introduction 1
1.1 About SINUMERIK

From simple, standardized CNC machines to premium modular machine designs – the 
SINUMERIK CNCs offer the right solution for all machine concepts. Whether for individual parts 
or mass production, simple or complex workpieces – SINUMERIK is the highly dynamic 
automation solution, integrated for all areas of production. From prototype construction and 
tool design to mold making, all the way to large-scale series production.
Visit our website for more information SINUMERIK (https://www.siemens.com/sinumerik). 

1.2 About this documentation

Target group
This documentation is intended for the user of Analyze MyWorkpiece /Toolpath.

Benefits
The Operating Manual helps users familiarize themselves with the control elements and 
commands. It enables users to work with Analyze MyWorkpiece /Toolpath.

Standard scope
This documentation only describes the functionality of the standard version. This may differ 
from the scope of the functionality of the system that is actually supplied. Please refer to the 
ordering documentation only for the functionality of the supplied drive system.
It may be possible to execute other functions in the system which are not described in this 
documentation. This does not, however, represent an obligation to supply such functions 
with a new control or when servicing.
For reasons of clarity, this documentation cannot include all of the detailed information 
on all product types. Further, this documentation cannot take into consideration every 
conceivable type of installation, operation and service/maintenance.
The machine manufacturer must document any additions or modifications they make to the 
product themselves.

Analyze MyWorkpiece /Toolpath
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Websites of third-party companies
This document may contain hyperlinks to third-party websites. Siemens is not responsible for 
and shall not be liable for these websites and their content. Siemens has no control over the 
information which appears on these websites and is not responsible for the content and 
information provided there. The user bears the risk for their use.

1.3 Documentation on the internet

1.3.1 Documentation overview SINUMERIK 840D sl
You will find extensive documentation on the functions of SINUMERIK 840D sl from version 4.8 
SP4 at 840D sl documentation overview (https://support.industry.siemens.com/cs/ww/en/view/
109766213).

You can display documents or download them in PDF and HTML5 format.
The documentation is divided into the following categories:
• User: Operating
• User: Programming
• Manufacturer/Service: Functions
• Manufacturer/Service: Hardware
• Manufacturer/Service: Configuration/Setup
• Manufacturer/Service: Safety Integrated
• Manufacturer/Service: SINUMERIK Integrate/MindApp
• Information and training
• Manufacturer/Service: SINAMICS

Introduction
1.3 Documentation on the internet

Analyze MyWorkpiece /Toolpath
8 Operating Manual, 06/2023, A5E48913345B AH

https://support.industry.siemens.com/cs/ww/en/view/109766213
https://support.industry.siemens.com/cs/ww/en/view/109766213


1.3.2 Documentation overview SINUMERIK operator components
Comprehensive documentation about the SINUMERIK operator components is provided in the 
Documentation overview SINUMERIK operator components (https://
support.industry.siemens.com/cs/document/109783841/technische-dokumentation-zu-
sinumerik-bedienkomponenten?dti=0&lc=en-WW).
You can display documents or download them in PDF and HTML5 format.
The documentation is divided into the following categories:
• Operator Panels
• Machine control panels
• Machine Pushbutton Panel
• Handheld Unit/Mini handheld devices
• Further operator components
An overview of the most important documents, entries and 
links to SINUMERIK is provided at SINUMERIK Overview - Topic 
Page (https://support.industry.siemens.com/cs/document/109766201/sinumerik-an-overview-
of-the-most-important-documents-and-links?dti=0&lc=en-WW).

1.4 Feedback on the technical documentation
If you have any questions, suggestions or corrections regarding the technical documentation 
which is published in the Siemens Industry Online Support, use the link "Send feedback" link 
which appears at the end of the entry.

1.5 mySupport documentation
With the "mySupport documentation" web-based system you can compile your own individual 
documentation based on Siemens content, and adapt it for your own machine documentation.
To start the application, click on the "My Documentation" tile on the mySupport homepage 
(https://support.industry.siemens.com/cs/ww/en/my):

Introduction
1.5 mySupport documentation
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The configured manual can be exported in RTF, PDF or XML format.

Note
Siemens content that supports the mySupport documentation application can be identified by 
the presence of the "Configure" link.

1.6 Service and Support

Product support
You can find more information about products on the internet:
Product support (https://support.industry.siemens.com/cs/ww/en/)
The following is provided at this address:
• Up-to-date product information (product announcements)
• FAQs (frequently asked questions)
• Manuals
• Downloads
• Newsletters with the latest information about your products
• Global forum for information and best practice sharing between users and specialists
• Local contact persons via our Contacts at Siemens database (→ "Contact")
• Information about field services, repairs, spare parts, and much more (→ "Field Service")

Introduction
1.6 Service and Support
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Technical support
Country-specific telephone numbers for technical support are provided on the internet at 
address (https://support.industry.siemens.com/cs/ww/en/sc/4868) in the "Contact" area.
If you have any technical questions, please use the online form in the "Support Request" area.

Training
You can find information on SITRAIN at the following address (https://www.siemens.com/
sitrain). 
SITRAIN offers training courses for automation and drives products, systems and solutions from 
Siemens.

Siemens support on the go

With the award-winning "Siemens Industry Online Support" app, you can access more than 
300,000 documents for Siemens Industry products – any time and from anywhere. The app 
can support you in areas including:
• Resolving problems when implementing a project
• Troubleshooting when faults develop
• Expanding a system or planning a new system
Furthermore, you have access to the Technical Forum and other articles from our experts:
• FAQs
• Application examples
• Manuals
• Certificates
• Product announcements and much more
The "Siemens Industry Online Support" app is available for Apple iOS and Android.

Data matrix code on the nameplate
The data matrix code on the nameplate contains the specific device data. This code can be read 
with a smartphone and technical information about the device displayed via the "Industry 
Online Support" mobile app.

Introduction
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1.7 Important product information

Using OpenSSL
This product can contain the following software:
• Software developed by the OpenSSL project for use in the OpenSSL toolkit
• Cryptographic software created by Eric Young.
• Software developed by Eric Young 
You can find more information on the internet:
• OpenSSL (https://www.openssl.org)
• Cryptsoft (https://www.cryptsoft.com)

Compliance with the General Data Protection Regulation
Siemens observes standard data protection principles, in particular the data minimization rules 
(privacy by design).
For this product, this means:
The product does not process or store any personal data, only technical function data (e.g. 
time stamps). If the user links this data with other data (e.g. shift plans) or if he/she stores 
person-related data on the same data medium (e.g. hard disk), thus personalizing this data, 
he/she must ensure compliance with the applicable data protection stipulations.

Introduction
1.7 Important product information
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Safety instructions 2
2.1 Fundamental safety instructions

2.1.1 General safety instructions

WARNING
Danger to life if the safety instructions and residual risks are not observed 
If the safety instructions and residual risks in the associated hardware documentation are not 
observed, accidents involving severe injuries or death can occur.
• Observe the safety instructions given in the hardware documentation.
• Consider the residual risks for the risk evaluation.

WARNING
Malfunctions of the machine as a result of incorrect or changed parameter settings
As a result of incorrect or changed parameterization, machines can malfunction, which in turn 
can lead to injuries or death.
• Protect the parameterization against unauthorized access.
• Handle possible malfunctions by taking suitable measures, e.g. emergency stop or 

emergency off.

2.1.2 Warranty and liability for application examples
Application examples are not binding and do not claim to be complete regarding configuration, 
equipment or any eventuality which may arise. Application examples do not represent specific 
customer solutions, but are only intended to provide support for typical tasks.
As the user you yourself are responsible for ensuring that the products described are 
operated correctly. Application examples do not relieve you of your responsibility for safe 
handling when using, installing, operating and maintaining the equipment.

2.1.3 Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.

Analyze MyWorkpiece /Toolpath
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In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens’ products and solutions constitute one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected 
to an enterprise network or the internet if and to the extent such a connection is necessary 
and only when appropriate security measures (e.g. firewalls and/or network segmentation) 
are in place.
For additional information on industrial security measures that may be implemented, please 
visit 
https://www.siemens.com/industrialsecurity. 
Siemens’ products and solutions undergo continuous development to make them more 
secure. Siemens strongly recommends that product updates are applied as soon as they are 
available and that the latest product versions are used. Use of product versions that are no 
longer supported, and failure to apply the latest updates may increase customer’s exposure 
to cyber threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed under 
https://www.siemens.com/cert. 
Further information is provided on the Internet:
Industrial Security Configuration Manual (https://support.industry.siemens.com/cs/ww/en/
view/108862708)

WARNING
Unsafe operating states resulting from software manipulation
Software manipulations, e.g. viruses, Trojans, or worms, can cause unsafe operating states in 
your system that may lead to death, serious injury, and property damage.
• Keep the software up to date. 
• Incorporate the automation and drive components into a holistic, state-of-the-art industrial 

security concept for the installation or machine.
• Make sure that you include all installed products into the holistic industrial security concept.
• Protect files stored on exchangeable storage media from malicious software by with suitable 

protection measures, e.g. virus scanners.
• On completion of commissioning, check all security-related settings.

2.2 Observe data security regulations
In addition to the recommendations for the Security information (Page 13), further points 
relating to data security and data protection must be observed.

Safety instructions
2.2 Observe data security regulations
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Passing on data
When passing on recorded data to third parties or transferring data to other devices, observe the 
following:
• Use encrypted e-mails to transfer data.
• When forwarding files via e-mail, encrypt the data again by yourself (password protection).

Restrict the data access
Restrict the access to recorded data:
• Only grant authorized users access to servers or computers.
• Ensure safe handling of passwords, logins and access rights.
• Save data on encrypted data storage media only (hard disk encryption).
• Only use encrypted USB flash drives.
• Sign the recorded data.

Safety instructions
2.2 Observe data security regulations
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Overview 3
3.1 Analyze MyWorkpiece /Toolpath (AMWT)

Overview
Analyze MyWorkpiece /Toolpath (AMWT) is a software for the visualization and analysis of NC 
programs. Application areas include turning and milling machines in the industry sectors mold 
making or aeronautics that demand ultraprecise surface machining.
Whereby, the AMWT allows contour accuracy, surface quality and machining speed of a 
workpiece to be optimized before production.
If problems occur during the production of a workpiece, the AMWT helps to rectify faults by 
analyzing the program and the surface.

3.2 Licensing with FlexLM
FlexLM License Manager allows you to manage licenses for Analyze MyWorkpiece /Toolpath. 
Depending on whether you have purchased multiple licenses and want to use them on the 
network or only want to use one license locally, FlexLM allows you to manage the licenses:
• Use the license server

Configure the server to manage floating licenses.
• License file (node-locked)

Copy the license file to your computer/server.

Licensing model
Two different licenses are available for Analyze MyWorkpiece /Toolpath:
• Professional (pro) - with this license, all functions of Analyze MyWorkpiece /Toolpath are 

available without restriction.
• Standard - with this license, only selected functions are available. Functions that are not 

available are grayed out.

Feature Standard Professional
4D point cloud ✓ ✓
STL visualization ✓ ✓
Transformation ✓ ✓
Tool visualization ✓ ✓
G code processing (4D coloring, filtering, 
etc.)

✓ ✓

Manual measurement - ✓
Data import G code + DES_POS (EDGE) ✓

Analyze MyWorkpiece /Toolpath
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Feature Standard Professional
Time series view 2 graphs ✓
Surface reconstruction (virtual milling) - ✓
Number of visual scenes 1 Unlimited
Number of models 2 per scene Unlimited
Python scripting interface - ✓
Teamcenter interface - ✓
Vector visualization Curvature + orientation ✓

Calling the license dialog
The following options are available for licensing:
• FlexLM; allows licenses to be stored in the network (floating licenses) or also locally.

Opening the license dialog
Run "Help > License" to open the dialog with the same name.

① Settings for the FlexLM server
② Path to the license file
③ License status

Overview
3.2 Licensing with FlexLM
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Configuring the license server
The license server provides the licenses you have purchased. The number of licenses determines 
how any users can work with Analyze MyWorkpiece /Toolpath at the same time. If a user closes 
the application, the license is released again (floating licenses).
1. Under "Help > License", select the type of licensing you want to use:

– Under FlexLM, activate the "Use License Server" option to use floating licenses.
– Under "Server IP Address", enter the IP address of the FlexLM server.
– Enter the port number for the FlexLM service (default 29000). 

Note that this port must be enabled in the firewall of the server in order for Analyze 
MyWorkpiece /Toolpath to communicate with the license server.

2. Click on "Activate license" to apply the selected licensing type. The button is not active if a 
valid license was already assigned.
The type of license being used is displayed to the left of the button.

3. Click on "Change license" to apply the new license. 
The already active license is still used if the new license is not valid.

Note
Managing licenses
LMTOOLS is provided for managing licenses. This software enables you to manage your licenses 
on the server or perform diagnostics, if necessary. This software is not part of the Analyze 
MyWorkpiece /Toolpath software package, but must be downloaded from the manufacturer 
(FLEXERA).

Using a license file (standalone license) (node-locked)
If you want to use only one license, you can store the corresponding license file locally on your 
computer or in a network directory:
1. Save the license file in the designated folder.
2. Activate option "Use license file".

The path input field is activated.
3. Click the "Browse" button and navigate to the folder where the license file is located.
4. Click on the license file and then on "Select".

The path to the license file is displayed and Analyze MyWorkpiece /Toolpath can be used.
5. Click on "Change license" to complete licensing.

Overview
3.2 Licensing with FlexLM
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3.3 Using the Shareware mode

License check
At startup, Analyze MyWorkpiece /Toolpath checks if a license is available:
• An error message is generated if no license is found.
• The "License" dialog is opened using function "Activate license", which allows you to setup a 

license via FlexLM.

Working without a license
A shareware version of the software is available for testing Analyze MyWorkpiece /Toolpath.
The demo version is subject to the following restrictions:
• The title of the software contains a supplement after "shareware version".
• You can only edit demo files that were supplied with the demo version. The "Sample Files" 

dialog only permits access to these files. You cannot open your own files.
• Apart from free file selection, most of the functions of the full version are available.

Note
Settings not active
When working without license, the settings under "Tools > Settings" are not active with the 
exception of the "License" tab.

Overview
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FlexLM server
If Analyze MyWorkpiece /Toolpath cannot connect to the FlexLM server or if no valid FlexLM 
license file is found, it will start in "shareware mode" (Licensing with FlexLM (Page 17)).

3.4 Recommended hardware and software configuration
The following hardware is recommended to operate Analyze MyWorkpiece /Toolpath:

Hardware configuration
CPU: Intel Core i5 Processor @ 2.8 GHz or higher with 64-bit support (AMD not tested)
GPU: nVidia GeForce GT 710 or higher (AMD not tested)
hard disk memory: 20 GB free hard disk memory (can increase depending on the use)
Monitor resolution: 1920x1080
Internet: required for software activation, FlexLM license use and Capture connection

Operating system
Operating system: Windows 10 with the latest service pack

Security requirements
From the user side, it is not necessary to configure Analyze MyWorkpiece /Toolpath. 
Analyze MyWorkpiece /Toolpath is ready for use after the compressed file has been unzipped.
You must first set up license management, or this is already available.
Account management is not used.

Overview
3.4 Recommended hardware and software configuration
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Reset
The application uses the AppData folder of the user for logging and to save configuration 
files or temporary files. The registration is used for setting data. Both can be deleted if script 
reset.ps1 in the user folder is run.

Uninstalling
Uninstallation is possible if you run script uninstall.ps1 in the user folder. This script also 
calls reset.

Overview
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Working with the AMWT 4
4.1 Starting

Starting - exiting Analyze MyWorkpiece /Toolpath
To start AMWT, proceed as follows:
1. Open the directory in which Analyze MyWorkpiece /Toolpath is located. 
2. Double-click on "amwt_desktop.exe". AMWT is opened with the settings last used.
3. To exit the application, in menu "File", select command "Exit" or click on button "x".

Note
Start screen
The start of the program may be slightly delayed if the connection to the license server is slow. 
A start screen is displayed during startup. More detailed information is available at Licensing 
with FlexLM (Page 17).

4.2 Using workspaces

4.2.1 Creating/loading a workspace
In AMWT, the data of the current machining is collected in a workspace. All geometric data of the 
model and the current processing steps are saved in the workspace. The file format is *.amwt
As soon as a file is imported, AMWT creates an implicit workspace.

Note
Not saved in a scene
The settings of the following functions are not saved in a scene:
• Surface extraction (in the case of a temporary file that has not been saved)
• Graphs
• Offset

Analyze MyWorkpiece /Toolpath
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Creating a new workspace
Proceed as follows to create a new workspace:
1. Open AMWT.
2. Perform "File > New workspace".

The currently open workspace is closed. The unsaved changes can be rejected or saved.
The created workspace can be saved as follows.

Loading a workspace
Proceed as follows to open an already existing workspace:
1. Open AMWT.
2. Run "File > Load Workspace".

A prompt opens asking whether the unsaved changes to the current workspace are to be 
rejected or saved.
The "Load Workspace" dialog opens.

3. Select a file (*.AMWT) and click "Open".
The workspace is loaded and the files are shown in the sideview and the working area.

Recent workspaces
For quick access, the recent workspaces are listed at "File > Recent Workspaces".

4.2.2 Saving a workspace

Save workspace / Save workspace as
Save the current editing status of the workspace. In addition to the changed data, for example, 
geometric machinings and perspectives are also saved.
Proceed as follows to save a workspace:
1. Perform "File > Save workspace" to save the open workspace with the current settings.

Or
2. Perform "File > Save workspace as" to save the workspace under a new name.

The "Save workspace" dialog opens.
If you want to change the path, select an alternative storage location for the workspace.

3. Enter a name, and click "Save".
The workspace is encrypted for saving in AMWT format. The file can only be opened with 
Analyze MyWorkpiece /Toolpath .

Working with the AMWT
4.2 Using workspaces

Analyze MyWorkpiece /Toolpath
24 Operating Manual, 06/2023, A5E48913345B AH



Closing the scene/program
If you want to close a scene or Analyze MyWorkpiece /Toolpath and there are unsaved changes 
in scenes, a dialog will appear where you can accept or discard the changes.

4.3 Importing data

Importing a file into AMWT
Workpieces can be described in several data formats. A list of these formats can be found 
at Supported file formats (Page 31). These files must be created in the source programs, such 
as SINUMERIK Operate Trace. The AMWT itself does not provide any conversion functions.
Proceed as follows to import the data into AMWT:
1. Run "File > Import file(s)" to import data into a new scene.

The "Import file" dialog opens. 
The supported file formats are shown in the drop-down list of the file formats.

2. Select a format filter.
3. Navigate in the file system to the desired folder.
4. Select the file and click "Open".

For trace files, dialog "Trace File Import" is displayed. For details, see Importing trace files 
(Page 32).

A new scene is opened in the sideview of AMWT. The workpiece is displayed in the working 
area.
Alternatively, you can also import a model via the command line using the following string:
<application path><application name> <file path><file name>

Importing files with drag and drop
• Drag a file onto the icon on the desktop of your computer. If the format is compatible, AMWT 

starts and the file is loaded.
- OR -

• Drag a file into the working area of the open application.

Recently imported files
The files last opened are listed in the "Last files" menu item.
1. Execute "File > Recent File(s)".
2. Select the file you want to import.
3. The file is imported and is displayed in the workspace currently being used. 
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4.3.1 Monitoring the import sequence

Description
For larger files, the import of data into AMWT can take some time.
The import of files can be checked with the import sequence.
1. To do this click the "Control Panel" button.
2. The import sequence is shown on the right alongside the working area.
3. Click "Cancel" to interrupt the currently running import.

Large files
Some files may be very large, so opening them may take some time. During this time, a dialog 
with a progress bar is shown which indicates the state of the import and, if applicable, the 
conversion of the data into G-code.

Error display
A warning symbol is displayed if errors occur when importing data or when opening Python 
scripts.
• Click on the warning symbol to open a dialog that provides support when resolving the error.

4.4 Using scenes

4.4.1 Scenes - overview

Scenes in AMWT
After the files have been imported into AMWT or a workspace has been opened, the workpieces 
are shown in the working area.
"Scenes" are created in the sideview to manage the files. The following functions can be used 
via scenes:
• Import further files
• Activate and deactivate display of workpieces
• Show and hide points, lines and surfaces.
• Color picker
• Display evaluation and representation functions

Working with the AMWT
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1 Button to add another file
2 Scene
3 Alias/path of the activated file 1; A double-click can assign an alias to the path. 

The following characters are prohibited: `~!@#$%^&*—+=|:;<>«»,?/{}'"[].
4 Tooltip with path of the activated file
5 The alias/path of a second, deactivated file, which can be displayed together with the first file and overlays it.
6 Temporarily generated STL file after a surface reconstruction (Surface Extractor)
7 Evaluation functions available for the selected file
8 Evaluation and display functions for the selected file

Surface elements in scenes

Button Description
Calls the "Import Files" dialog to load another file into the scene.

Closes the selected file/scene
Extends the list.
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Button Description
Reduces the list

Shows the dialog for color-coding points, lines and measurements.

Shows and hides the points.

Shows and hides the lines.

Shows and hides the rendered surface (only for workpiece data that contains surface information)

Shows and hides the complete workpiece.

Saves the temporarily created STL file (Surface Extractor). Any unsaved files are discarded.

4.4.2 File selection in scenes

Evaluate files
Various functions to evaluate and represent the workpiece are available in the sideview. If 
several files are loaded to the scene, click on the entry under the particular scene.
The functions are integrated as widgets in the sideview.
1. Select the scene.

The available functions are displayed in the sideview. 
2. Click in the file or the model to display the functions for the particular file.
3. - Or -
4. The functions available for the selected file type are listed. The content changes with each 

file type
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1 Name of the scene
2 MPF file
3 Mesh file
4 Evaluation and representation functions of the selected file

Figure 4-1 Scene with two loaded files (here MPF file)

4.4.3 Workpieces superimposed on one another

Loading multiple workpieces into one scene
Via a scene, you can open various data of workpieces or the data of workpieces several times in 
one scene. You can compare the workpieces directly by alternately showing and hiding points/
lines.
1. In a scene, click on "Add model" ("+").

Dialog "Add model" is displayed.
2. Select a file and click "Open".

- OR -
Drag a file onto the working area of the active scene.
- OR -
Perform "File > Import file to active Scene".
- OR -
Execute "External source > Import Captured File(s) from Edge".
The file is loaded into the scene.

Machining actions, such as turning or moving, are applied to all loaded workpieces.
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Figure 4-2 Scene with two files
• For each loaded workpiece, you can modify the display independently of each other by 

clicking the respective button in the file bar.
• To select the evaluation functions for the model, click on the corresponding entry in the 

sideview.

4.4.4 Displaying functions

Evaluating workpiece paths
Functions to display and evaluate the data are shown when the corresponding file below the 
scene is selected. They are organized as widgets in the sideview.
Various functions are available to display and evaluate the tool paths and surfaces.

Function Description
4D Provides graphic evaluation functions, such as position values, velocity 

curve.
Points Lists the points in the tool path.
Measurements Enables various measurements to be made with points.
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Function Description
Transformation Allows you to move and rotate models.
T Enables a virtual tool to be shown and traversed along the tool path.
Selection Enables points to be selected according to specific criteria.
Events The recorded signals are listed in the "Events" widget. The events are listed 

according to HF events and OPI (NC variables).
GCode list Lists the part program. Available for JSON and MPF files, see Displaying and 

filtering GCode (Page 49).
GCode filter Depending on the GCode, allows points to be displayed or hidden.
Properties Lists various properties of the displayed workpiece.

4.5 Base data

4.5.1 Supported file formats

File types
The possible source formats must be created with the appropriate programs.
You can open the following data types in AMWT:
• NC or part programs:

– *.mpf: Part programs (ASCII file).
– *.cnc
– *.spf

• JSON
– *.json
– *.zip (json container)

• Mesh files:
– *.stl: Standard Tesselation language, the file format for describing the surface of 3D 

bodies (ASCII file). The format is supported by popular CAD programs, such as NX. The 
AMWT can import not only ASCII files, but also binary STL files.

• CSV:
– *.csv: comma separated values; trace files (also as XML)

• XML
– *.xml; XML file of a trace.

Large files require more time for the import.
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4.5.2 Importing trace files

Opening a trace file
When you import a trace file, the "Trace File Import" dialog is displayed automatically. In this 
dialog, you specify the parameters for the import of the trace data. Whereby, the signals 
recorded in the trace serve as basis.
The following parameters are displayed for files that are not data type "JSON":

Column Description
Signal Allows a signal to either be selected or deselected
Type Type of axis

Position Position value
Velocity Velocity value
Acceleration Acceleration value
Orientation Tool orientation
Torque Torque value

Assigned signal Axes are selected under size X, Y, Z, A, B, C, SP, scalar
Signal source 
type

Displays the signal source type, position value, velocity...

Description The description of the signal.

For JSON files, the following parameters are shown:

Column Description
Signal Allows a signal to either be selected or deselected
Symbol name Type of axis

Position Position value
Velocity Velocity value
Acceleration Acceleration value
Orientation Tool orientation
Torque Torque value

Assigned signal Axes are selected under size X, Y, Z, A, B, C, SP, scalar
Name Displays the name of the signal as it was provided from the JSON file, e.g. signal name...
Address Displays the address of the signal. Signals are characterized by the name and the address
Signal source 
type

Displays the signal source type (X1,....)

Selecting signals
• In the "Signal" column, select the signals that are to be considered for importing. The default 

is that all signals are selected.

User-defined
To condition the signals for AMWT, you must specify the axes and types:
1. At "Axis", select the axis for which the signal was recorded for each signal.
2. At "Type", select whether the signal has recorded a position, a velocity or an acceleration.
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Assigning automatically
• Click "Automatic selection" to assign the signals automatically to the axes and types.

Symbol names for custom signals
• Assign unique, expressive symbol names for your custom signals. The following characters 

are prohibited:  `~!@#$%^&*—+=|:;<>«»,?/{}'"[].

Import of 2D models
If, when importing, you only specify 2 components (i.e. X/Y), then the data set can already be 
imported, assuming that the third component is always 0.
X-Z --> Y is always 0.
Y-Z --> X is always 0, and so on

Tool length compensation
• Activate this option "Compensate tool length" when importing a trace file. 
This allows the different lengths of tools used for machining the workpiece to be taken 
into account during surface reconstruction. The tools used must be created in the tool 
identification database for this purpose. If tool length compensation has already been 
performed, this option is not required.

Generating graph data
Graph data can be generated to simplify analysis. The generated signal graphs are then shown 
in the graph display for evaluation, see also Signal evaluation (Page 111).

Triggering an import
• Click "Import" to import the signals.
A progress bar shows the progress. After the import, the workpiece is displayed in AMWT.

4.5.3 Part programs (NC programs)

Part programs (*.mpf)
The individual movements of the tool are specified as blocks in part programs. Different 
information is available depending on the part program.
Whereby, each program step corresponds to a point represented in the AMWT. 
Supplementary information, such as the feedrate, is also contained in the part program.

3-axis programs
In 3-axis programs, the positions in the X, Y and Z direction are programmed for the tool 
movement. Consequently, only such information that can be derived is available in the AMWT.

Working with the AMWT
4.5 Base data

Analyze MyWorkpiece /Toolpath
Operating Manual, 06/2023, A5E48913345B AH 33



For example, important information is:
• Representation of the workpiece as points and lines
• Path curvature 

5-axis programs
For 5-axis programs, in addition to the X, Y and Z positions, the spatial orientation of the tool is 
also specified. This allows not only the block information, but also the spatial orientation vectors 
of the tool to be calculated.
Whereby, the axes must be defined as A, B and C axes.
For example, important information for 3-axis programs is:
• Representation of the workpiece as points and lines
• Path curvature 

4.6 Surface elements

Menu bar
The main menu provides various functions for editing and representation.

Toolbar
A large number of functions are available in the toolbar.

Button Function
Adapts the point size in 5 stages. Larger Smaller

Adapts the line thickness in 5 stages. Larger Smaller

Adapts the length of the orientation vectors in 
11 stages. After reaching size 10, there is a jump 
back to 0 and vice versa.

Larger Smaller

Adapts the length of the curvature vectors in 11 
stages. After reaching size 10, there is a jump 
back to 0 and vice versa.

Larger Smaller
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Button Function
Adapts the length of the ABC vectors in 11 
stages (only for 5-axis CNC models). After reach‐
ing size 10, there is a jump back to 0 and vice 
versa.

Larger Smaller

Enables selection of a custom vector for display 
based on the name.

   

 Adjusts the length of the custom vectors in 11 
levels (only if custom vectors are present). After 
reaching size 10, there is a jump back to 0 and 
vice versa.

Larger Smaller

Shows the coordinate system

Increases the brightness

Shows and hides the non-selected points. This function is not available if signal graphs are used.

Selects all points between the start and end points of a tool path. If several points are selected, then 
the points the furthest apart from one another are used.

Deletes the point selection.

Hides all points during a rotation. The option is set in advance.

Shows and hides the center of rotation. The center is defined by double-clicking.

Sideview
The sideview is used to manage, display and select the imported files. The files are listed in 
scenes.

4.7 Program settings

Settings
Select "Tools > Settings" and open the dialog of the same name.
In this dialog, you can specify the setting for Analyze MyWorkpiece /Toolpath by clicking on 
the respective tab in the foreground.
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General
Specify the general settings in the "General" tab:

NC parser
the number of points to be used for polynomial interpolation by the NC parser.
This is the number of points calculated during a polynomial interpolation. The more points 
are entered, the higher the number of interpolation points and the longer interpolation takes.
Click "Apply" to update the polynomial interpolation with the new settings.

Sequence of the rotation of an ABC vector
ABC vectors depict the orientation of the ABC axes in space. For a rotation, you can set in 
advance the order in which the model is rotated about the respective axis:
• XY'Z''
• ZY'X''

Synchronization
Two methods are available to synchronize models:
• Based on center of mass
• Based on position (X, Y, Z) 
Click "Apply" to update the synchronization of the scene with the new settings.
More detailed information is available at Synchronizing models (Page 68).

Logging
Flash animation of the LOG button
You use this setting to specify how fast the LOG button should flash when a message is 
received.
Show log notification
You use this setting to specify how long a message should be shown in the bottom right-
hand corner.

Zoom
You define the zoom settings in the "Zoom" tab.

Zoom settings for the mouse wheel
• Inverting the zoom setting with the mouse wheel
• Invert the zoom direction for smooth zooming

Use scaled zooming
1. Activate this option to use the actual zoom value for zooming speeds.
2. Deactivate the option to work with a fixed zoom speed.

In the default setting, the option is not active.
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Shortcuts
In the "Shortcuts" tab, you can define which keyboard commands are to be used for the listed 
functions.
1. Click the shortcut button.
2. Execute the desired keyboard combination on the keyboard.

Appearance
You can assign different colors to the different model types for display in the print preview.
1. Click the color button of the model type.

The color selection dialog opens.
2. Click on the desired color and accept the selection with "OK".

STL viewer
To view STL files, you can also configure an external viewer of your choice. The STL files 
generated using Python scripts are then displayed using this viewer.
1. Under "Selected STL Viewer" enter a path to the *.exe file of the viewer.
2. To use the configured viewer, activate option "Use external viewer for STL visualization".
3. Also observe the notes regarding the properties required for the configured viewer.

Accepting settings
1. Click on the "Apply" button to save the settings and keep the dialog open.

- Or -
2. Click "OK" to accept the settings and close the dialog.

- Or -
3. Click "Default" to restore the default settings.

- Or -
4. Click "Cancel" to reject the settings.

Switching over the language
Under "Tools > Language" you can change the UI language. There is a choice of:
• English
• German
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4.8 Licenses and help

Calling the help function
Under "Help > Help" call up the operating instructions in the HTML5 format.
The operating instructions contains detailed information about Analyze MyWorkpiece /
Toolpath.

Licensing
The following options are available for Analyze MyWorkpiece/Toolpath licensing; for more 
information, see Licensing with FlexLM (Page 17).
• FlexLM; allows licenses to be stored in the network (floating licenses) or also locally.
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Displaying a workpiece 5
5.1 Displaying workpieces

Tabs and frames
The loaded data is displayed in the working area. Depending on your specific situation, the 
working area can be extended with tabs and frames:
• Tabbed view; you can toggle between the various tabs by clicking them.
• Tile; tiles allow the workpieces to be displayed with different settings next to each other.
• Sideview; the currently loaded workpieces are listed in the sideview. The icons allow you to 

assign user-defined colors, hide or show points, lines and surfaces, or close the file.
If you reload the data for the analysis, you can display it, for example, in another perspective.
The currently active view in a tab or frame is indicated on the selected tab.

Using tabs
The loaded data is displayed in the working area. 
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Proceed as follows to display the data in tabs:
1. Execute "Windows > Tabbed view".

The data opened is arranged in tabs. 
The functions displayed in the project navigation and toolbars always apply to the active tab.

Figure 5-1 Tabs
2. Click on the tab to bring the tab into the foreground.

Using tiles
Tiles allow the working area to be divided vertically and horizontally. Frames can be combined 
with tabs.

Note
New models are loaded as default in the vertical tile mode.

1. Execute "File > Import File" for each file that you want to display in AMWT.
2. Execute "Windows > Tiles".

The files are displayed in a vertical and horizontal distribution.
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3. Execute "Windows > Tabbed view" and then "Windows > Tiles" again.
The files are displayed in a vertical and horizontal distribution.

Figure 5-2 Frames
4. Click the "cross" in the tab title to close the tile, and therefore to close the scene. The tile is 

closed when the last tab title of a tile is closed. Alternatively, you can close the scene by 
clicking the "cross" in the sideview.

Size of the tiles
Depending on the requirement, you can adapt the horizontal and vertical sizes of the tile:
1. Move the mouse pointer over the boundary between two tiles.
2. When the mouse pointer becomes a double arrow, left-click.
3. Shift the mouse pointer (double arrow) with the left mouse button pressed.
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Evaluation functions in the tiles
Additional evaluation functions can be used when using JSON, JSON.zip, CSV and XML files. For 
models that support these features, you will see an up arrow or three dots displayed in the footer 
that can be moved with the mouse.

Figure 5-3 Evaluating a graph - overview
You can use the buttons to show additional graphical views of signals for evaluation. Detailed 
descriptions can be found under Signal evaluation (Page 111).

5.2 Displaying lines

Line representation
In the AMWT, the individual points (steps in the part program) are connected with lines.
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Adapting the line thickness
The thickness of the lines can be increased incrementally in steps. 
• Click the "Line thickness" button with the left mouse button.

Each click makes the line thicker until the maximum line thickness is reached.
The line thickness is adapted for all lines.

• Click the "Line thickness" button with the right mouse button.
Each click makes the line thinner until the minimum line thickness is reached.

Hiding lines
The loaded files are listed in a folder structure in the sideview
1. Open the folder of the desired file.

The shown surface elements are listed.
2. Deselect the lines to hide them.

5.3 Adapting the point display

5.3.1 Showing/hiding and selecting points

Points in the working area
Each displayed point represents a program step of the part program. To clarify the tool path, the 
points are connected with lines.

Selecting points
To analyze the machining of the workpieces, it is often necessary to display the properties of the 
individual points along the tool path. 
To do this, select these points.

Selecting points with the mouse
1. Import the workpiece into the working area.
2. Select the corresponding tool path in the scene.
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3. Click with the left mouse button on the points to select them.
Or:

4. Press the <Shift> key, click with the mouse pointer in the working area, and with the left-hand 
mouse button pressed, drag the area whose points are to be selected.
The selected points are highlighted.

Figure 5-4 Selected points

Revoking the point selection
To revoke the point selection, proceed as follows:
1. Press the <Ctrl> key and click the points to be deselected.

- OR -
2. Press the <Ctrl> key, click with the mouse pointer in the working area, and drag with pressed 

mouse button the area whose points are to be deselected.
- OR -

3. Click the button "Deselect point" to deselect all points of the selected scene.
- OR -

4. Press <n> on your keyboard.
The selected points are somewhat larger; the size is reset when the selection is canceled.
How to customize the shortcuts is described here: Program settings (Page 35).

Hiding points
The loaded files are listed in a folder structure in the sideview

Click the "Show/hide points" button to hide the points in the view.

Displaying point information
The following information can be displayed for selected points:
• Index; shows the respective point index (number of the point)
• Coordinates; displays the coordinates of the point in the machine coordinate system.
• Velocity; shows the velocity of the tool at this point
• Curvature; shows the curvature of the tool path at this point.
• NC code; displays the NC code of the point.
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1. Click the button Point information "I" to display the dialog including the available information.
2. Click the button including the information to display the relevant parameters.

The data are displayed at selected points in the working area.

Figure 5-5 Point information

Adapting the point size
You can adapt the size of the points step-by-step in five stages. 
• Click the "Point size" button with the left mouse button.

Each click makes the points larger until the maximum point size is reached.
The point size is adapted for all points.

• Click the "Point size" button with the right mouse button.
Each click makes the points smaller until the minimum point size is reached.

Show selected points only
If you want to concentrate on selected points, you can hide all the non-selected points:
1. In the toolbar, click the "Show selected points only" button.
2. All non-selected points are hidden.

If you click on the button again, all points are shown again - the previously selected points 
appear again.

Selecting points along a tool path
Proceed as follows to select points along a tool path:
1. Select two points on a tool path.
2. In the toolbar, click the "Select all points between first and last point" button.

All points between the two points are selected.

Displaying a workpiece
5.3 Adapting the point display
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5.3.2 Points widget

Displaying selected points
The "Points" widget shows all points of the loaded file. If the points in the working area have been 
selected, the display can be restricted to the selected points.

① Selected tool path
② Buttons for showing points:

• Show selected points only
• Restrict display to selected points
• Cancel restricted view
• Show point information

③ Displayed parameters of the points
④ Selected points in the table
⑤ Selected points in the working area
⑥ Shows context menu to enter the number of the program line that is to be displayed.
⑦ Shows context menu with additional scroll functions.
⑧ Displays the point table next to the model (extend view)

Displaying information
For example, the following information is shown for the selected points:
• Numbering of the point
• X, Y, Z coordinate
• Velocity

Displaying a workpiece
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• Orientation vector
• Curvature
• Curvature vector
• NC code
• Tool ID
The available information depends on the type of imported data.

Scroll functions
A right-click can show context menus, which offer various scroll functions:
1. Right-click in the points table.

Figure 5-6 Scrolling the point widget
2. Enter the line number which you would like to display.

- OR -
3. Right-click on the scroll bar.
4. A context menu with a range of functions is shown:

– Scroll here; jumps to the line position where the right-click was executed.
– Top; jumps to start
– Bottom; jumps to end
– Page up; moves up one page
– Page down; moves down one page
– Scroll up; moves up one line
– Scroll down; moves down one line

Selecting points
Select the points either from the points table or the working area. The points table and the 
representation in the working area are linked.

Displaying a workpiece
5.3 Adapting the point display
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Extend view
You can extend the view to show the points table clearly alongside the associated model. The 
points table is then shown alongside the model, and may cover other displayed models.
1. Click the button.

2. The points table is shown alongside the model.

Figure 5-7 Extended view
3. Click the button to close the extended view.

5.3.3 Selecting points

Searching for distances between points
The AMWT provides the "Selection" widget for the analysis. The selection function allows 
searches for distances between points and the selection of points that meet a specific criterion. 
The points found are then selected.
Proceed as follows to select points at defined distances:
1. Enter an operator, such as ">", "<" or "=", to enter a distance evaluation. You can also combine 

"<" or ">" and "=" to represent ≤ or ≥.
2. Enter a distance [mm].
3. Click "Select" to initiate the process. The points found are then shown.

Displaying a workpiece
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5.4 Displaying and filtering GCode

Displaying a part program in the GCode list
If the data contains a part program (GCode), the program can be displayed. The display is only 
possible with JSON and MPF files.
1. Select the scene.
2. Select the model and click on the "GCODE list " widget in the foreground.

Figure 5-8 GCode view
3. Select the lines in the GCode to select the corresponding points in the model. The points are 

shown in red.
- Or -

4. Mark the points in the model. The lines in the GCode appear selected.
5. Click "Extend view" to display the GCode in an extra column alongside the model view. This 

is only possible for JSON and MPF files.

6. Click "Select channel" to display the code of the desired channel.
7. Activate the "Show only selected" option to display only the lines of the selected points.

Note
The same NC code can apply to many different points.

Searching with keyword
You can use the keyword search to display lines of code that contain this term. The search is case-
sensitive.
1. Enter a keyword in "Search keyword".
2. The lines containing the word/term are displayed immediately.

Displaying a workpiece
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Filtering GCode
The various GCodes, which contain a part program, can be filtered under the "GCode filter" tab. 
In addition to GCode, points that were calculated using polynomial interpolation, can be filtered.
1. Click on "GCode filter", to display the list of GCodes contained in the part program.
2. Click on the corresponding button to show or hide the command type.

Filtering polynomials
If the part program contains lines with polynomial interpolations, then these can be filtered.

Displaying a workpiece
5.4 Displaying and filtering GCode
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5.5 Points for the polynomial interpolation

Model with polynomial interpolation
Contains the code for the displayed polynomial interpolations model. The number of points to 
be used in the polynomial interpolation can be set in "Tools > Settings > General" The more points 
are used, the more precise the interpolation. The following graphic shows a comparison of two 
models with polynomial interpolation, one with 100 points and one with 20.

① Selected line in GCode with a polynomial interpolation
② 100 points selected
③ 20 points selected

Figure 5-9 Polynomial interpolation

5.6 Show coordinate systems

Coordinate systems
If you have loaded a workpiece in the working area, you can display the following coordinate 
system:

Button Function
Global coordinate system (large). The coordinate system stands in the center of a virtual cuboid drawn 
around the borders of the model. In a rotation, the coordinate system is also moved and can go out of the 
field of view. The size of the coordinate system does not change when the model is enlarged or reduced.

Displaying a workpiece
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① Coordinate system that can disappear on rotation out of the display field.
② Fixed coordinate system that is shown at a fixed location and also rotates during rotation.
③ Coordinate system after rotation. The flexible coordinate system is no longer visible.

Figure 5-10 Displaying the coordinate system
For orientation, while analyzing a model, a small coordinate system can be displayed in the 
upper right-hand corner, 

Displaying a workpiece
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5.7 Adjust color display

Setting object colors
Using the color picker, you can assign colors to the individual objects in the working area. This 
allows you to color-code, for example, the lines and points of overlying workpieces in different 
colors for a better differentiation.

① Element selection, buttons for selecting the element
② Preview, shows how the elements are color-coded
③ Color palette, shows the current colors

Figure 5-11 Color picker

Displaying a workpiece
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Elements
Use the buttons to select the elements whose colors you want to change:

Button Description
Allows you to change the color of the points.

Allows you to change the color of the selected points.

Allows you to change the color of the tool paths.

Allows you to change the color of the result line of a distance measurement.

Allows you to change the color of the guide lines for a measurement.

Allows you to change the color of an area.

Change the color of elements
The colors of the workpiece elements can be changed using the color palette:
1. Click the button of the element you want to recolor.
2. Select the color in the color palette. The color palette contains various predefined colors.

The preview shows how the color changes.
3. Click "OK" to apply the color.

- OR -
4. Click on "Default" to restore the default settings.

Displaying a workpiece
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Color palette for free colors
If the predefined colors do not match the requirements, you can use a color palette to define free 
colors.
1. Click the "rainbow" to call up the color palette.

The dialog opens.

Figure 5-12 Color palette
2. Define the requested color and add it to your colors (Custom colors).
3. Click "OK" to apply the setting.

Displaying a workpiece
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Performing transformations 6
6.1 View transformation

6.1.1 Moving objects

Moving the view with the mouse
This action moves the view to the object, while the object itself does not change.
Objects in the AMWT working area are moved with the mouse:
1. Right-click the object and hold the mouse button down.
2. Move the object to the desired position with the mouse. Actually, the object is not moved, but 

rather the view of the object is changed (the camera is moved).

Figure 6-1 Moving the view to the object

6.1.2 Rotating objects

Turning the view of the object with the mouse
This action turns the view of the object, while the object itself does not change.
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Objects in the working area are turned or rotated with the mouse.
1. Left-click the object and keep the mouse key pressed.
2. Move the mouse to turn the object in the desired view around the set pivot point. Actually, 

the object is not turned, but rather the view of the object is changed (the camera turns 
around the object).

Figure 6-2 Turning objects

Hiding points
This function is active per default. The points of each model of the corresponding scene are then 
hidden while the camera moves.
Use these functions for models featuring a high number of points to perform the rotation faster and 
more fluently.

Defining and displaying the center of rotation
You set the center of rotation (pivot) as follows:
1. Enlarge the model until you see the individual points.
2. Double-click on the point where you want the center of rotation to be.
3. Click the "Show center of rotation" button to mark the point.

This function shows the center of rotation as a large dot.

The center of rotation is shown highlighted,

Performing transformations
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6.1.3 Zooming objects

Enlarging or reducing objects
Enlarge objects in the working area to investigate interesting structures in large format. Zoom 
out to return to a clear view. Actually, the object is not enlarged or reduced, but rather the 
camera moves closer or further away from the object.
• The zoom direction can be inverted in the settings (Program settings (Page 35)).

Procedure
1. Click the object.
2. Coarse zoom

Press the scroll wheel and rotate it backward (enlarge) or forward (reduce).
3. Smooth Zoom

Keep the mouse wheel pressed, and move the mouse to zoom smoothly.

Performing transformations
6.1 View transformation
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Figure 6-3 Zooming objects

Zooming via Page up - Page down
Press the <Page down> and <Page up> keys to enlarge or reduce the object gradually.

6.2 Setting a transformation

6.2.1 Widget transformation

Moving and rotating models
In the "Transformation" widget, you can move and rotate models by defined values.
If you loaded 2 models into the scene, you can align them by selecting two points. 
For example, if you superimpose the trace of a machining operation over the part program, 
you can detect mechanical disturbances such as vibrations. To do this, the two points in the 
models must correspond.

Performing transformations
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Transformation widget
You can find the widget in the page view of Analyze MyWorkpiece /Toolpath.

① Input fields for moving in the TX, TY and TZ direction
② Input fields for rotating about the RX, RY and RZ axis
③ Apply: Updates the values in data structures after a move or rotation.

Updating (Applying) values in data structures
In the various evaluation functions, such as graphs, position values are calculated or displayed. 
When you move or rotate a model, the position data changes without updating the values in the 
data structures.
• Click "Apply" to update the data in the different data structures (graphs, models...).

Note
Always run "Apply"
If you have moved or rotated models, always click "Apply" to keep the data structures consistent.

6.2.2 Align models

Requirement
You have loaded two models into a scene.

Performing transformations
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Shifting models (Translation)
The last loaded model can be shifted by entering the various values:
1. Enter the values for shifting in the X, Y or Z direction. The model is immediately shifted.

- OR -
2. Click the arrows on the right edge of the input fields to change the values for shifting.

① Shift
② Align

Figure 6-4 Translation

Aligning models
If you want to make the two models coincide, the points in the models must correspond.
1. Select one point in each of the models.
2. Click the "Get from point selection" button (②).

The two selected points and thus the two models are made to coincide.

Model not aligned Model realigned

Performing transformations
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Updating position data in graphs
In the graphical evaluation you can display position data as graphs, for which then 
corresponding position data is displayed. When you shift or rotate a model, the position data 
changes.
Click on "Apply" to transfer the current position data from the model to the graphical 
evaluation.

6.2.3 Rotating models

Rotation
The last loaded or selected model can be rotated by entering various values:
1. Enter the values for rotating in the RX, RY, or RZ direction. The model is immediately rotated.

- OR -
2. Click the arrows on the right edge of the input fields to change the values for rotating.

① Angle values for rotation
• RX: Rotation around the X axis
• RY: Rotation around the Y axis
• RZ: Rotation around the Z axis

② Display mode for the Euler angle
Figure 6-5 Rotation

Mode
Under Mode you set which Euler angle you want to use for the rotation:
• ZYX-Euler: The first rotation is about the Z axis (fixed axis), then there is a rotation about Y' (Y 

axis rotates along with the rotation about Z), then a rotation about X' (rotates along with the 
rotation about Z and Y').

• XYZ-Euler: The first rotation is about the X axis (fixed axis), then there is a rotation about Y' 
(Y axis rotates along with the rotation about X), then a rotation about Z' (rotates along with 
the rotation about X and Y').

Performing transformations
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Figure 6-6 Euler angle scheme
The following example shows a rotation of 40° around ZYX and XYZ.

Performing transformations
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Figure 6-7 Euler angle

Performing transformations
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Using the navigation window 7
7.1 Navigation window

Navigation window
The navigation window is loaded into the workspace together with the model at the bottom 
right and is anchored.
The partial image currently displayed is shown with a red border.

Figure 7-1 Navigation window
In the navigation window, the following points are available in the toolbar (from left to right):
• Zoom
• Set standard perspectives
• Synchronize model views
• Create and save a screenshot (report)
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7.2 Set default camera view

Available perspectives
The perspective corresponds to the viewing direction of the camera aimed at the object. You set 
the perspective using the navigation window toolbar.

Figure 7-2 Navigation window toolbar
Several different perspectives are available in AMWT:

Button Meaning
From the top

From the bottom

From the front

From the rear

From the left

From the right

Home view (perspective when opening)

7.3 Synchronizing models

Synchronization
If you have opened your workpiece for analysis in several tabs or tiles, you can synchronize the 
views in the tabs or tiles. This is possible with up to five scenes. If you want to synchronize more 
than five scenes, the "Synchronize" button is deactivated.
• You can synchronize up to five models.
• The functions of the Navigation window are deactivated as long as the models are 

synchronized.

Using the navigation window
7.3 Synchronizing models
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• The synchronized models can be zoomed, moved and rotated together.
• After synchronization, a tooltip is shown which displays the synchronization.
2 synchronization types are available for the function. You make the settings under "Tools > 
Settings" (Program settings (Page 35)).

Based on the center of gravity
Synchronization "Based on center of mass" is better for various file types; if the coordinate 
systems differ, then the zoom level is not synchronized. In the example below, it can be seen that 
the models can be synchronized in spite of the different coordinate systems.
• Therefore, activate option "Based on center of mass".

① Files, type *.CSV
② Files, type *.MPF

Using the navigation window
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Based on position (X, Y, Z)
Synchronization "Based on position" has an advantage if the file type is such that the coordinate 
system is the same for all synchronized files, e.g. in the case of files from different machining 
phases. If you zoom into the examples below, then the models disappear from the camera range 
and are no longer visible. This is why we recommend that synchronization is realized via the 
center of gravity.
• Therefore, activate option "Based on position (X, Y, Z)".

① Files, type *.CSV
② Files, type *.MPF

Main and ancillary scenes
To synchronize scenes, a differentiation is made between the main scene and ancillary scenes. 
A scene is defined as main scene, where the synchronizing button was printed first. All other 
scenes, which are open, are classed as ancillary scenes.
The main scene defines the motion to be executed (rotating, shifting, zooming,...) of the 
ancillary scenes. The positions of the models before synchronization are rejected, and the 
models in the ancillary scenes orient themselves to the main scene.

Using the navigation window
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Performing synchronization
1. To synchronize the models, call up the navigation window toolbar.

2. Click the "Synchronize" button.
3. Click the "Synchronize" button for the second display.

The pressed button indicates that the synchronization is activated.
4. Activate the synchronization in all displays to be synchronized.

All other buttons are deactivated during the synchronization run.
In the example, the main scene has a red border, the ancillary scenes have a blue border, the 
synchronization type is "center of gravity".

Figure 7-3 Synchronous display
The views of the selected models are now synchronized. Changes in one display are 
replicated concurrently in the other display.

Using the navigation window
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Zooming or moving individual models
If you want to move or zoom individual models, proceed as follows:
1. Click the model to set the focus.
2. To do this, press the <Alt> key and execute the movement/zoom.
If you want to display the synchronized models again, you must deactivate and then 
reactivate the synchronization.

7.4 Zooming and adapting a display

Enlarging or reducing objects
The tools for enlarging or reducing objects are provided in the navigation window toolbar.
1. Open the navigation window toolbar.

Figure 7-4 Enlarging and reducing
2. Perform "Zoom in" to enlarge the view.
3. Perform "Zoom out" to reduce the view.

Adapting the workpiece view
Rather than zooming manually, you can also perform two operations with fixed enlargement.
1. Perform "Fit to Screen" to adapt the workpiece to the available work area.
2. Perform "Fit to Selection" to adapt the point selection to the size of the work area.

7.5 Creating and editing screenshots

Creating screenshots
To document the analysis of a workpiece, it often suffices to show the workpiece in a specific 
perspective. To freeze and forward this perspective, you can capture screenshots, augment 
them with appropriate text or markings, and export them.

Using the navigation window
7.5 Creating and editing screenshots

Analyze MyWorkpiece /Toolpath
72 Operating Manual, 06/2023, A5E48913345B AH



To create a screenshot, proceed as follows:
1. Click the "Save screenshot" button in the navigation window toolbar.

AMWT creates a screenshot of the current working area. 
2. Click "Save" to save the screenshot as a file.
3. Click "Copy" to copy the screenshot to the Windows clipboard.

Displaying additional information
You can display more information for documentation and the unambiguous interpretation of 
the displayed pictures:
• Date/time
• GCode colors
• Tool identification colors

Using the navigation window
7.5 Creating and editing screenshots

Analyze MyWorkpiece /Toolpath
Operating Manual, 06/2023, A5E48913345B AH 73



Using the navigation window
7.5 Creating and editing screenshots

Analyze MyWorkpiece /Toolpath
74 Operating Manual, 06/2023, A5E48913345B AH



Animating tool paths 8
8.1 Tool animation

Displaying tool paths
The tool paths programmed via part programs can be displayed animated in AMWT. The 
animations show the machining process for the workpiece.
The animations are controlled via the T widget:
1. Open AMWT.
2. Import the file and select the scene.
3. Click the "T" button.

The widget is displayed.
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① File name of the tool path
② Displaying a tool
③ The point where the tool is currently located
④ Buttons for controlling the animation
⑤ Controller for the velocity of the tool movement
⑥ Option to display the tool at selected points
⑦ Position and orientation of the tool
⑧ Properties of the tool

Animating tool paths
8.1 Tool animation
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Virtual tool
A virtual tool is displayed automatically when you call the T widget. The position and orientation 
of the tool are specified. The properties of the tool can be adapted, see Properties of the tool 
(Page 78).

① Virtual tool
② Tool path

Figure 8-1 Tool display

See also
Analyzing orientation vectors (Page 124)

8.2 Controlling tool animations

Controlling animation
An animation allows the tool to be moved along these paths so that the machining can be 
simulated.
• To activate tool animation, click on "Display tool".
The animation can be started, stopped or interrupted via buttons:

Runs the animation forward.

Runs the animation backward.

Moves the tool one step forward.

Moves the tool one step backward.

Animating tool paths
8.2 Controlling tool animations
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Moves the tool to the end of the path.

Moves the tool to the start of the path.

Stops the animation.

Note
When using a NVIDIA graphic card, the tool is not displayed at the selected points.

Controlling the velocity
The velocity with which the tool moves along the path is controlled with a slider.

Figure 8-2 Controlling the velocity

8.3 Properties of the tool

Properties of the tool
You can adapt the properties of the tool for the simulation. This gives you a more realistic view 
of the workpiece machining. The tool is represented as a cylinder, either with a flat tip 
(cylindrical) or a rounded tip (spherical).
You can adapt the following properties:
• Tool diameter; the default value is 6.
• Tool length; the default value is 40.
• Depth; the value depends on the tool diameter; the value describes the penetration depth of 

the tool in the workpiece. A cylindrical tool does not have any depth because it is flat.

Tool tip
It is possible to choose between two tool forms:
• Cylinder; the tool is a cylinder without tip.

• Sphere; the tool is a cylinder with a rounded tip.

Animating tool paths
8.3 Properties of the tool
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See also
Tool animation (Page 75)
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Using vectors 9
9.1 Displaying orientation vectors

Using tool orientation vectors
With AMWT, you can show orientation vectors in order to analyze tool paths. The vectors are 
displayed at each point of the tool path. If points are selected, then the orientation vectors are 
shown only at the selected points.

Figure 9-1 Orientation vectors at selected points

Note
Orientation vectors can be displayed only when orientations exist in the data source. Possible 
sources are, for example, 5-axis part programs.
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To display the orientation vectors, proceed as follows:
1. Click on "Change orientation vector length".

An orientation vector is displayed at each point.
2. Click the button with the left mouse button to extend the vectors until the maximum length 

is reached.
3. Click the button with the right mouse button to shorten the vectors. The orientation vectors 

are hidden when the length is at "0".

The vectors can be lengthened or shortened step-by-step in 11 stages. The currently set value is dis‐
played via a tooltip. After "10", the display jumps back to "0" and the vectors are hidden. 5/10 is the 
default value.

Tool path without vectors Tool path with vectors

Using vectors
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9.2 Displaying curvature vectors

Using curvature vectors
With AMWT, you can show curvature vectors in order to analyze tool paths. The vectors are 
displayed at each point of the tool path. If points are selected, the curvature vectors are shown 
only at the selected points.

Figure 9-2 Curvature vectors at selected points
To show the curvature vectors, proceed as follows:
1. Click on button "Change curvature vector length".

A curvature vector is displayed at each point. 
2. Click the button with the left mouse button to extend the vectors until the maximum length 

is reached.
3. Click the button with the right mouse button to shorten the vectors. The curvature vectors 

are hidden when the length is "0".

The vectors can be lengthened or shortened step-by-step in 11 stages. The button tooltip shows the 
degree of the lengthening, e.g. "0/10". After "10", the display jumps back to "0" and the vectors are 
hidden. "5/10" is the default value.

Using vectors
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9.3 Displaying ABC vectors

ABC vectors
ABC vectors are only available for some models, such as the 5-axis CNC models of the file types 
CNC and MPF, for example. They show the orientation of the ABC axes in space. The vectors are 
displayed at each point of the tool path. If points are selected, the ABC vectors are shown only 
at the selected points.
Notifications display the following information about the part program:
• ORIWKS is not programmed in the part program.
• ORIMKS is programmed in the part program.

Using vectors
9.3 Displaying ABC vectors
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Figure 9-3 ABC vectors
Proceed as follows to show the ABC vectors:
1. Click the "Change ABC vector length" button.

An ABC vector is displayed at each point. 
2. Click the button with the left mouse button to extend the vectors until the maximum length 

is reached.
3. Click the button with the right mouse button to shorten the vectors. The ABC vectors are 

hidden when the length is "0".

The vectors can be lengthened or shortened step-by-step in 11 stages. The button tooltip 
shows the degree of the lengthening, e.g. "0/10". After "10", the display jumps back to "0" and 
the vectors are hidden. 5/10 is the default value.

9.4 Displaying custom vectors

Custom vectors
For custom vectors, the import data must contain data from which vectors can be derived.
Without this output data, you cannot show custom vectors. You will be informed accordingly.
• CNC files: 

Process the feedrates F_X, F_Y, F_Z and use the result as the basis to create a custom vector, 
which you can visualize in AMWT.

• Trace files:
Define custom vectors in the "Import trace file" dialog when importing the model.
For example a 3-axis machine records the data DES_POS|1, DES_POS|2, DES_POS|3 and 
CTRL_DIFF|1, CTRL_DIFF|2, CTRL_DIFF|3. You see the tool with the DES_POS data points. You 
can then combine CTRL_DIFF|1, CTRL_DIFF|2, CTRL_DIFF|3 to create a vector <CTRL_DIFF|1, 
CTRL_DIFF|2, CTRL_DIFF|3 > and visualize the vectors along the data points.

If points are selected, the custom vectors are shown only at the selected points.
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Trace files
The following graphic shows the torque as a custom vector.
During import, the data TORQUE|1, TORQUE|2 and TORQUE|3 are assigned to a vector, which 
can then be displayed.

Figure 9-4 Custom vectors

Change vector length
Proceed as follows to show the custom vectors:
1. Click the "Change length of custom vector" button.

A custom vector is displayed at each selected point. If no points have been selected, the 
vectors at all points are displayed.

2. Click the button with the left mouse button to extend the vectors until the maximum length 
is reached.

3. Click the button with the right mouse button to shorten the vectors. The custom vectors are 
hidden when the length is "0".

The active vectors can be lengthened or shortened step-by-step in 11 stages. The button tooltip 
shows the degree of the lengthening, e.g. "0/10". After "10", the display jumps back to "0" and 
the vectors are hidden. 5/10 is the default value.
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Selecting the active custom vector
If you have defined several custom vectors for your model, you can select the respective active 
vector for display. The vectors are color-coded. Only one vector can be shown at a time. The 
calculated points of the vectors in each case are listed in the "Points" widget in a column.
1. Click the "Select active custom vector" button.

The menu with the custom vectors is displayed.
2. Click the button of the custom vector to be displayed.

Figure 9-5 Select active custom vector
If you now show custom vectors, the color of the selected active custom vector is used. In the 
example, the vector for torque is displayed in "ocher", for velocity in "violet".

Torque Velocity
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Analyzing 10
10.1 Using the fourth dimension

10.1.1 Using the fourth dimension

Overview
Workpieces are displayed and described in the three spatial dimensions. In addition to these 
dimensions, AMWT allows the points and the lines of the displayed workpiece to be assigned 
further properties using colors. In effect, the workpiece (points and lines) is represented in four 
dimensions. The associated properties and axes/paths can be selected, and depend on the 
associated base data.
The 4D evaluation is performed in the "4D" widget.
1. Select the file in the scene.

- Or -
Click the workpiece in the working area.
The evaluation widget is displayed.

2.  Click "4D".
The widget with the same name is displayed.
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① List of the available properties
② List of the axes
③ Slider to set the minimum/maximum value and the value range
④ Minimum/maximum values of the selected property
⑤ Copy min./max. values to other scenes
⑥ Restoration of original minimum/maximum values (previously defined values)
⑦ Restoration of original color assignment (previously defined colors)
⑧ Options for the display

Figure 10-1 4D widget

10.1.2 Variables for the 4D evaluation

Selecting a variable
Only those physical variables defined in the base data can be evaluated via the 4D widget. Not 
all data is offered with each data source.
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The following variables can be selected:

Type Variable Description
Position Position The positions of the points in the coordinate system used in the part program
Velocity Velocity The velocity distribution along the tool path.
Orientation Orientation vector The orientation vector of the tool (the orientation of the tool in the coordinate 

system).
Curvature Curvature The curvature distribution along the tool path.
Acceleration Acceleration The acceleration distribution along the tool path.
Torque Torque Torque distribution along the tool path.
Jerk Jerk The jerk (change in acceleration) distribution along the tool path.
GCode   The GCodes used are displayed in color (JSON and MPF files). If part programs 

contain polynomial interpolations, then these are also displayed with the GCode.
Tool ID   The tool IDs are displayed in color (JSON files)
The user-defined signals from the trace import are added at the end of the table.

The scalars can be measured or calculated. You will find a corresponding entry in the 
selection menu of the 4D widget.

10.1.3 Minimum/maximum values in the 4D evaluation

Selecting the type
Select from the "Type" drop-down list the type of the signal to be displayed. The content of the 
drop-down list depends on the source data. If, for example, no signal of the orientation vectors 
was recorded in the trace, you cannot select it.
The selection of the signal type also changes the unit.

Minimum values and maximum values
The minimum and maximum values are actively assigned from the "4D colors" dialog.
The values are assigned to the colors of the spectrum in values increasing from left to right. 
The minimum and maximum values allow the resolution to be set. 
As the assignment uses the highest minimum/maximum values, you may need to edit the 
minimum/maximum values manually. For example, the G0 traversing velocity is used as 
the maximum value for velocities. This velocity, however, is significantly higher than, for 
example, the traversing velocity for milling, so that those areas of actual interest are not 
resolved.
To optimize the display, proceed as follows:
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Assigning minimum/maximum values using sliders
You can change the minimum/maximum values continuously using the sliders.
1. Move the left-hand slider to adjust the minimum values.
2. Move the right-hand slider to adjust the maximum values.
3. Click on the slider and shift the complete value range to either the left or right.

Changes to the value range and color changes are immediately accepted.

Entering minimum/maximum values
1. Enter the minimum/maximum values in the text boxes.
2. Press the <Enter> key to accept the values.
3. Click on "Restore original limits" to restore the previously set values.
4. Click "Clear 4D Coloring" to reset the coloring. The min./max. settings for coloring are not 

deleted.
5. Click on "Copy limits to all open models" to transfer selected limit values to all modules that 

have been opened.

Options
The following color options are available for the display:
• "Display values outside of the range in gray"; values which are outside of the min./max. values 

are displayed in gray.
• "Swap colors" switches the color values. The color scale is inverted (blue to red and vice 

versa).
• "Absolute values"; Shows the values of the selected type in absolute values. The values are 

color-coded.
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Example
The following example shows the velocity distribution with automatically assigned minimum/
maximum values (left) and manually adjusted values (right). The left-hand figure shows the 
areas with maximum velocity (red) during the G0 movement (red). The velocity in the workpiece 
is not replaced by the assigned minimum and maximum values. In the right-hand figure, the 
maximum value has been greatly reduced to show the areas in which the tool travels slower 
(blue).

Default minimum/maximum values Adjusted minimum/maximum values

See also
Variables for the 4D evaluation (Page 90)

10.2 Measuring distances

10.2.1 Distance measurements

Overview
You determine the distances between points, lines and surfaces via the geometric measuring 
functions. This allows you to determine any irregularities in the tool path, e.g.:
• Points whose distance is too small.
• Lines whose distance varies.
• Points whose distance from a surface varies.
You can adapt the color representation of the objects, see Adjust color display (Page 53).
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Measuring functions
The following measuring functions are available:
• Measuring the distances between points (Page 95)
• Measuring the distance between points and lines (Page 96)
• Measuring the distance of a point from a plane (Page 96)
• Measuring the distance for the points of two lines (Page 97)
• Measuring the distance between two points of a trace (Page 98)

Measurement widget
For measuring distances between points, AMWT offers the widget "Measure"

① Buttons for the measuring functions
② Display options for the measurements:

• Deletion of the selection upon change of the measurement method; deletes the point selection when changing 
the measurement method.

• Displays information on the measurements in the scene; displays the relevant information for the measurement 
in the scene.

③ History; the history table shows detailed information on the measurements. If you click on the lines of the measuring 
report table, the previous measuring calculation is performed.

Figure 10-2 Measurement widget
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Call extended view
The measurement widget can be shown in the extended view. The results of the measurement 
can then be clearly shown.
• Click the button.

10.2.2 Measuring the distances between points

Measure the distance between two points
This function determines, for example, distances between points that are too short for the NC 
and so could cause performance problems.
To measure the distance between two points, proceed as follows:
1. Import the source file into the AMWT.
2. Zoom until the individual points are resolved.
3. Click the button "Measure the distance between two points".
4. Select two points. 
5. The distance between the two points is displayed under "History" in "Results".

Figure 10-3 Measuring the point distance
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10.2.3 Measuring the distance of a point from a plane

Measure the distance of a point from a plane
This function determines the distance of a point from a plane. The plane is defined by selecting 
three points. After selecting the fourth point, the application automatically creates a 3 or 4-point 
plane according to the point selection.
The original 3-point plane is extended into a 4-point plane, creating a vertical line connecting 
the plane to the fourth selected point.
To measure the distance, proceed as follows:
1. Import the source file into the AMWT.
2. Zoom until the individual points are resolved.
3. Click the button "Distance between a point and a plane".
4. Select the three points that define the plane.
5. Select the fourth point. 
6. The plane is drawn.

The results from the distance measurement are displayed under "History" in "Results".

Figure 10-4 Measuring the point distance to a plane

10.2.4 Measuring the distance between points and lines

Distance between line and point
This function determines the distance of a point from a line. The line is defined by selecting two 
points. The distance from the line is determined for the third selected point.
To measure the distance, proceed as follows:
1. Import the source file into the AMWT.
2. Zoom until the individual points are resolved.

Analyzing
10.2 Measuring distances

Analyze MyWorkpiece /Toolpath
96 Operating Manual, 06/2023, A5E48913345B AH



3. Click the button "Distance between a point and a line".
4. Select the two points to define a line.
5. Select another point. 

The distance between the point and the line is determined and displayed under "History" in 
"Results".

Figure 10-5 Measuring the distance between a point and a line

10.2.5 Measuring the distance for the points of two lines

Distance from one line to another line
The distance between two lines is measured by first defining a line by selecting two points. A 
second line is then defined and the perpendicular drawn from the initial line to the end point of 
the second line.
To measure the distance, proceed as follows:
1. Import the source file into the AMWT.
2. Zoom until the individual points are resolved.
3. Click the button "Measure the distance between two lines".
4. Select the two points that define the first line.
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5. Select a third point that represents the initial point of the second line.
6. Select the fourth point.

If necessary, the first line is lengthened until the perpendicular can be drawn to the first line. 
The distance is determined under "History" and displayed in "Results".

Figure 10-6 Distance between two lines

10.2.6 Measuring the distance between two points of a trace

Measure the distance between two points on the tool path
This function measures the distance between two points on the tool path
To measure the distance, proceed as follows:
1. Import the source file into the AMWT.
2. Zoom until the individual points are resolved.
3. Click the button "Measure the distance between two points on the tool path".
4. Select two points on a path that you wish to determine the distance between.
The distance between the two points is calculated by the software travelling along the tool 
path. If you select another point, the distance is recalculated accordingly.
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Figure 10-7 Measure the point distance on the tool path
Unlike the "Measure the distances between points" function, the shortest path between two 
points is determined.

Figure 10-8 Measure the shortest distance between two points

10.3 Toolpath Extension Wizard

10.3.1 Toolpath Extension Wizard - Overview

Overview
With the analysis, signal characteristics can be mathematically analyzed using scripts. To do this, 
AMWT provides various predefined scripts, which can be used:
• clustering_kmeans.pyd: K-Means-Clustering algorithm - this algorithm groups data; it does 

this by attempting to separate samples into n groups with the same variance. This script 
works on several signals, which results in a model with 4D coloring.

• clustering_kmeans_plotly.py: K-Means-Clustering algorithm - for several signals (>2), 
supplies an HTML representation as result.
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• curvature_anomaly: Curvature anomaly detector algorithm - this algorithm is an automatic 
anomaly detector and utilizes three different methods:
Euler, entropy, and velocity difference
This script works with position signals, e.g. (X,Y,Z), which result in a 4D color signal.

• signal_differences_data.py: Analyzing signal differences; using this script, two vectors (i.e. 3 
signals) are compared from two trace files. A result chart (image) is generated and displayed 
in a web browser.

• signals_length_data.pyd: This script calculates the euclidean distance from three signals in 
a trace file. It is useful, for example, if you wish to analyze 'CONTROL DIFF' signals.

• signals_length_plotly.py: This script calculates the euclidean distance from three signals in a 
trace file. It is useful, for example, if you wish to analyze 'CONTROL DIFF' signals. A result chart 
(image) is generated.

• signal_differences_plotly.pyd: This script compares two vectors (i.e. three signals) in two 
trace files. A result chart (image) is generated and displayed in a web browser.

• surface_reconstruction_AMWSurf.pyd: Surface reconstruction from imported models. The 
tool database is automatically generated and assigned according to activetoolIDs. Adapt your 
tool data in menu "Extensions/Tool ID Database".

Result display
The results are displayed in charts, HTML plots or with a rendered surface.

Developing Python scripts
You can also develop your own Python scripts to evaluate signals. A development environment 
is available for this purpose.
Detailed information is provided under Analyze MyWorkpiece /Toolpath - Python API 
Developer Guide (Page 177).
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10.3.2 Running through the Toolpath Extension Wizard

Calling the wizard
You call the Toolpath Extension Wizard as follows:
• In the main menu, execute "Extension > Toolpath Extension Wizard". The wizard start page 

opens.

On the start page, you can see the individual steps to perform the analysis:
1. Selecting a script
2. Enter the data and assign
3. Enter parameters and assign
4. Parameterize script output
The individual steps must be executed one after the other. It is not possible to skip over a 
step.
Errors while entering data are displayed, along with a possible countermeasure.
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Note
You can also navigate through the wizard using the Enter key and the Backspace key.

Wizard structure
The wizard is subdivided into the areas Print preview and Main view.

① Print preview with the steps to be executed
② Main view with information about the various steps and entering data
③ Script selection
④ Buttons (blue) to show the file selection
⑤ Buttons (orange) for additional data input, e.g. signal selection or signal configuration.
⑥ Navigation buttons
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10.3.3 Selecting a script

Analytics scripts
You can find the available scripts under script selection in the drop-down list.
1. Open the wizard.
2. In the drop-down list, select the script to be evaluated.

The steps required are displayed in the main view.
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10.3.4 Data input

Entering data and parameters
Section "Data input" can be subdivided into two parts. The data (model data) must first be loaded 
and then the signals selected.
Data is required to run a Python script. This data can be selected by selecting the model 
already being used in the application or files, and loaded from the hard disk.

10.3.5 Selecting signals

Signal selection
The available signals are listed in the signal selection. If the Python script contains additional 
signal requirements, then the list is automatically filtered, and the labeling indicates the 
expected signal selection.
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A button for each required signal is shown in the page view

1. Click on the button to show the data input elements.
2. Select the signal that you must configure. The script specifies the input.
3. Continue with the next step.
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10.3.6 Entering parameters

Parameter input
You can enter your own values as parameter for the Python script in this data input window.

10.3.7 Script output

Output of result files
The Python script generates a *.bin, an *.HTML, or an *.STL file. This binary file contains a new 
signal and an interactive chart as data, which are available for the generated signal. The file is 
automatically loaded if the selected data file is not available after running the script. The new 
signal is displayed in 4D coloring.
1. Adapt the path under "Output file".
2. Under "Attach new signal as", enter a name for the signal file.
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As a graph in the signal display
The new signal can be displayed as a graph together with the other model signals.

Figure 10-9 Display signal
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As a signal in the 4D evaluation
The signal is displayed in the 4D evaluation after successful script execution.

Figure 10-10 Signal in 4D

10.3.8 Starting the script

Start to run the script
Start to run the script after you have entered the data.
• Click on the "Run" button.

The progress of the Python script is displayed.
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After the script has run, the display shows whether the execution was successful.
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HTML data visualization
The script generates an HTML file, which is automatically opened in the standard browser after 
the script has been run successfully.

10.4 Signal evaluation

Displaying signal graphs
If the models are based on JSON, CSV or XML files, then the associated signals can be displayed 
for evaluation. To do this, an upward arrow which serves as a splitter is displayed in the footer 
of the working area. Up to five signals can be displayed.
1. Click on the splitter to show the display.

- Or -
2. Place the mouse pointer on the splitter (upward arrow or 3 dots).

The mouse pointer changes its appearance.
3. Move the splitter with pressed mouse button. 

The graph display becomes visible.
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Figure 10-11 Displaying the graph
The following functions are available via the buttons:

Button Function
Shows a menu for selecting the model and the signals.

Applies the zoom to all the displayed graphs.

The points shown in the signal display are shown as "selected" in the display of the model.

The points selected in the model are also displayed in the signal graph.

Allows threshold values to be defined.

G-code series Displays the G-code used in the footer of the displayed signal.
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Button Function
Tool change Shows in the graph where a tool change took place, including the number of the new tool.

Allows the display of multiple signals to be subdivided into tiles.

10.4.1 Selecting signals

Selecting signal below the model
The graphs can be displayed for every JSON, CSV or XML model. If multiple files are open in a 
scene, then they are shown in the signal display. The corresponding number is displayed in the 
lower left-hand corner for each model.
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Correspondingly, only one entry is shown for one file:
1. Click the button to call the selection menu for the loaded files and signals.

The selection menu is displayed.

2

1

3

① Selected model
② Signal selection list
③ Number of the model in the scene

Figure 10-12 Signal selection
2. Open the submenu for signal section, and select the desired signal.

The graph is displayed.

You can display up to five signals.

Analyzing
10.4 Signal evaluation

Analyze MyWorkpiece /Toolpath
114 Operating Manual, 06/2023, A5E48913345B AH



10.4.2 Zooming graphs

Zooming a graph area
If you would like to see an area of the signal curve in detail, you can zoom the graph.
1. Left-click in the graph.
2. Keep the mouse button pressed, and drag the mouse pointer in the desired direction.

When you release the mouse button, the selected section is displayed.

Zooming via the shortcut menu
Alternatively, you can zoom via the shortcut menu:
1. Right-click in the graph.
2. Select "Zoom in" from the shortcut menu to zoom in the graph by one stage.

- Or -
3. Select "Zoom out" from the shortcut menu to zoom out the graph by one stage.

Restore view
You can restore the original view:
1. Right-click in the graph.
2. Select "Restore original view" from the shortcut menu.

The graph is displayed in its original size.
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Synchronizing the zoom in all graphs
If you opened multiple signals, you can synchronize the representation of the graphs. The zoom 
in/zoom out is transferred to the other graphs by a zoom action.
• Click the button to activate the function:

If synchronization is deactivated, then the Y is adapted so that all visible points of the graph 
are displayed.

Figure 10-13 Graph not zoomed

Figure 10-14 The upper graph is zoomed, the lower graph as well
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The points shown in the graph are shown as "selected"
The view of the graph can also be synchronized with the display of the model. The points shown 
in the graph can be shown as selected in the model. This helps you to see which area of the 
model contains the displayed graph. 
The function "Select the points shown in the graph" is preset.
1. Click the inactive button to activate the point selection. It is then no longer grayed out.

The points shown in the graphs are then shown as "selected" in the model.

Hiding points in the model that are not shown in the graph
Points that are outside the graphs are not displayed.
• Click the active button to activate the point selection. It is then no longer grayed out.
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Points which are not shown in the graphs are also hidden in the model.

Figure 10-15 Hiding points in the model

Marking selected points in the graph 
The point selection in the model can also be displayed on the graph shown:
• Click the button to activate the point selection in the graph. It is then no longer grayed out.

The points selected in the model are also marked in the graph.
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Figure 10-16 Selecting points in the model and graph

10.4.3 Setting threshold values
Areas of graphs in the signal display can be masked by threshold values. The affected parts of the 
graph are then no longer shown as selected.
Threshold values cannot be set for all signal types. With corresponding signals, the button 
then appears inactive.

Analyzing
10.4 Signal evaluation

Analyze MyWorkpiece /Toolpath
Operating Manual, 06/2023, A5E48913345B AH 119



Single threshold value
A single threshold value can be moved from the bottom to the top:
1. Load the signal into the display.
2. Click the "threshold value" button and select "Single threshold value" from the shortcut 

menu. The button displays the single threshold value.

3. The threshold value is displayed as a gray area with a line. The current threshold value 
appears in the display field.

4. Move the line until you have covered the area of no interest.

Figure 10-17 Single threshold value
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Double threshold value
With a double threshold value, you can mask an area in the graph:
1. Click the "threshold value" button, and select "Double threshold value" from the shortcut 

menu. The button displays the double threshold value.

2. The threshold values are displayed as gray areas at the top and bottom of the display. The 
values are displayed in the "Upper value" and "Lower value" display fields.

3. Move the lines until you have covered the areas of no interest.

Figure 10-18 Double threshold value

Invert areas
If you want to mask the opposing areas, activate the "Inverted areas" option.
The mask is now shown inverted.
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Deleting threshold values
If you want to hide the threshold values again, cancel the selection in the shortcut menu.

10.4.4 Scaling a signal display

Displaying multiple graphs
If you have loaded multiple signals into the display - up to five are possible - you can scale the 
display.
1. Click the button to arrange the graphs in tiles.

2. Select how you want to arrange the graphs in the displayed menu:
– Tiles
– Vertical only
– Horizontal only

The representation of the graphs changes correspondingly.

Adapting colors
You can adapt the colors of the background, graphs and threshold values in each tile individually.
1. To do this, right-click to call a shortcut menu.
2. Select "Appearance" to call a submenu.
3. Select background, graph or threshold value to call a submenu for color selection.
4. Select the color in which you want to see the representation.

The change in color is retained when the system resets to the original view.
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10.5 Events widget

Structure and properties
After the data have been imported, they are displayed in Analyze MyWorkpiece/Toolpath. The 
recorded signals are listed in the "Events" widget.
The events are listed according to HF events and OPI (NC variables).

Figure 10-19 Events widget
If you click an event, the entry is opened, and the points are shown as "selected" in the 
model.

10.6 Property widget

Listed data
The data of the model are listed in the Properties widget. Depending on the loaded model, the 
data may vary:
• For MPF files: number of points, number of orientations, for example
• For XML or CSV files: channel information, for example
• For capture files: machine properties, signal properties, for example

Analyzing
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10.7 Analyzing orientation vectors

Tool orientation for 5-axis programs
Orientation vectors can be used currently only for 5-axis programs that have defined the tool 
orientation via A, B and C axes. Orientation vectors can be displayed only in such programs. Such 
vectors describe the spatial orientation of the tool. For information on how to display orientation 
vectors, see Displaying orientation vectors (Page 81).

Visual assessment
Like points and curvatures, an initial visual assessment can also be made for orientation vectors. 
Adjusting the direction of view and adapting the display size allows any already inharmonious 
vectors to be detected. You can also display the tool path in an animation, see also Tool 
animation (Page 75).
• Are the vectors roughly parallel (provided permitted by the geometry) - ① and ②?

If the vectors run inwards or outwards, the tool must also perform unnecessary movements.

Figure 10-20 Orientation vector - Inclination
• Do the vectors lie in a plane - ③?

If the vectors do not lie in a plane, the tool must perform unnecessary movements (③).

Figure 10-21 Orientation vector - Plane
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10.8 Analyze points and velocities visually

Visually analyzing points and lines
Significant faults in the path and surface can be recognized in the first analysis. To do this, load 
the workpiece into AMWT and optimize the display until all details are well visible.
High quality data shows an overall harmonic picture:

Point distances are uniform
The points should be distributed uniformly.

Figure 10-22 Isolated points
If areas with anomalies are apparent, further analysis steps can be performed, for example, 
by measuring the distances between points and lines, see also Measuring the distance 
between points and lines (Page 96).
You can determine the associated data in the program/trace from the information available 
for the point.

Velocity distribution is even
An even velocity distribution indicates that the tool is moving at constant velocity. The tool 
does not decelerate, but moves at constant velocity along the path. 
If the visual check does not suffice, you can use the 4D widget for the evaluation.

Analyzing
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The following figure shows places where points in the path are missing. The associated 
4D evaluation shows a color change at these places, see also Using the fourth dimension 
(Page 89). To evaluate velocities, "Velocity" must be selected as the type.

Point distribution Point distribution with velocity

Unusual velocity change (color change from green to blue) indicates that the tool is braking 
or accelerating.

Analyzing
10.8 Analyze points and velocities visually

Analyze MyWorkpiece /Toolpath
126 Operating Manual, 06/2023, A5E48913345B AH



Reconstructing/extracting a surface 11
11.1 Using the mesh view

Using the mesh view
The "Mesh" function displays the surface representation contained in an *.STL file.
To display the workpiece rendered, proceed as follows:
1. Import the file into Analyze MyWorkpiece Toolpath.
2. In the sideview, click the scene containing the file.
3. The "M" button is operated automatically if you loaded an STL file.
4. Click the button for point or line representation to show or to hide these.

AMWT displays the surface representation for the workpiece.

2

1

① Scene
② File with rendered surface elements (M)

Figure 11-1 Mesh
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11.2 Reconstructing a surface

11.2.1 Surface reconstruction
Trace files can be recorded via Analyze MyWorkpiece /Capture and transferred to Analyze 
MyWorkpiece /Toolpath. The data from these trace files can be used to reconstruct the surface 
of the workpiece. If the recording took place in the machine coordinate system (MCS), Toolpath 
transfers the coordinates to the workpiece coordinate system (WCS). 

Note
No G0 commands
No G0 commands are considered for the reconstruction.

Requirement
• The trace data contain the XYZ coordinates (3-axis machine) or the XYZ coordinates and two 

rotary axes for a 5-axis machine.
• Tool length compensation was used during import to account for the lengths of the different 

tools.
– Axes and spindle have been defined.

• The tools used are listed in the tool identification database.

Procedure
• Import trace file, consider tool length compensation, select axis signals and spindle
• Select the "surface_reconstruction_AMWSurf" script in the extension wizard
• Select scene (the WCS scene)
• Define signals (the WCS signals)
• Select spindle
• Set reconstruction parameters
• Set file output
• Start reconstruction

Reconstructing/extracting a surface
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Import trace file
In order to perform a surface reconstruction, the trace file must contain the necessary data (XYZ 
coordinates, tool identifiers or Active Tool ID, etc.)
1. Execute "File > Import file" and select the desired file.

The import dialog opens.

2. Activate the "Tool length compensation" option.
3. Select the signals for the X, Y and Z signals (see example above).
4. Select a spindle signal.
5. Click "Import" to import the data with the appropriate settings.

Depending on the amount of data, the import may take a long time.
After the import, the model is displayed in the workspace.

Importing XML and CSV files
For XML and CSV files, the signal address and description of the recorded signals are also 
displayed:

Reconstructing/extracting a surface
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Changing symbolic names
Symbolic signal names are displayed in the second column. You can change these names:
• To do this, click on the pencil icon and enter a new name.

11.2.2 Running through the Toolpath Extension Wizard

Start the wizard
After you have imported the trace file, proceed as follows:
1. Execute "Extension > Toolpath Extension Wizard".

The wizard will appear and guide you through the process step by step.
2. Select the script.

The wizard then describes the next steps.
3. Click on "Next" to call the following wizard page.

Reconstructing/extracting a surface
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4. Here you select the scene containing the back-transformed data (WCS...) of the workpiece.

Figure 11-2 Selecting the scene
5. Click on "Next" to call the following wizard page.
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11.2.3 Defining axes

Defining X, Y, and Z axes
After the back transformation, the signals of the axes are mapped with the prefix "WCS".
1. Select the axes one after the other, e.g. "WCS_CommandAxisPosition".

2. Click on "Next" in each case to call the following wizard page.
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Defining the spindle
For the reconstruction it is necessary to select the spindle signal.
1. Select the signal you chose for the spindle during import.

Figure 11-3 Defining the spindle
2. Click on "Next" to call the following wizard page.
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11.2.4 Set reconstruction parameters

Entering parameters
With different parameters you define the volume section, the accuracy and the camera view of 
the reconstruction. For the reconstruction, a cuboid auxiliary body (bounding box) is defined, 
which defines the reconstructed volume. Only points that lie within the cuboid are used for 
reconstruction.

① Camera view of the auxiliary object (bounding box)
② Grid size
③ Center of the bounding box
④ Corner points of the bounding box
⑤ Side length of the bounding box

Cuboid area and grid size
Use the "Cuboid view" to select the perspective from which you are looking at the workpiece.
• Select the appropriate perspective in the drop-down list.
With the grid size you define the precision of the reconstruction. The smaller the value, the 
tighter the grid, the more accurate the reconstruction, but the greater the computation time.
• Enter a value for the grid size. The default setting is 0.4.

Reconstructing/extracting a surface
11.2 Reconstructing a surface

Analyze MyWorkpiece /Toolpath
134 Operating Manual, 06/2023, A5E48913345B AH



Define the volume of the cuboid (bounding box)
The bounding box is calculated from the minimum or maximum TCP data in the workpiece 
coordinate system (WCS) after the G0 data has been removed. The center is the center of gravity 
of the bounding box.
The edges of the cuboid are displayed in color, with the selected cuboid view highlighted in 
blue. The bounding box can be rotated and zoomed together with the workpiece.
When you open the "Parameter Input" dialog, the bounding box will be displayed.

① Minimum value in Z direction (values < 0)
② Maximum value in Z direction
③ Z axis in the coordinate system

Figure 11-4 Example of a workpiece with bounding box (camera view from behind)
The individual points can be used to position the box in space and to change its size. 
Negative values are possible.

Reconstructing/extracting a surface
11.2 Reconstructing a surface

Analyze MyWorkpiece /Toolpath
Operating Manual, 06/2023, A5E48913345B AH 135



The input fields each contain the values for the X, Y and Z directions (in that order).
• Center: By changing the X, Y and Z coordinates, the center of the cuboid can be moved in 

space. The position of the cuboid to the workpiece can be checked in the navigation window.
– Center:  XY Z

• Corners: The corners define the side faces of the cuboid. By entering the X, Y and Z values, 
the corners and thus the side faces of the cuboid can be moved by entering minimum or 
maximum values. 
– Min.: X Y Z
– Max.: X Y Z
This causes an enlargement/reduction as well as a shift of the cuboid in space.

• Side length: Select the "Side lengths" option to adjust the sides of the cuboid in the X, Y, and 
Z directions respectively. The position of the cuboid in space remains unchanged.
– Length: X Y Z

Restricting the point cloud
If you want to reconstruct only a certain section of the workpiece, you can select the point cloud 
of interest before the reconstruction and hide all other points in the workspace using the "Show 
selected points only" option. This makes it possible to reconstruct smaller areas with higher 
resolution without losing the overview.

11.2.5 Performing reconstruction

Defining the script output
When you have entered all the parameters of the surface reconstruction, you can start the 
reconstruction with the last two steps in the wizard:
1. Click on "Browse" to specify the storage location and name of the output file.

Alternatively, you can use the default path and file name.
2. Click on "Next" to call the "Results" dialog.

Start reconstruction
• Click on "Execute" to start the script execution.

The progress display shows the current status of reconstruction.
As soon as the reconstruction is finished, the result parameters will be displayed. Some 
background processes are still running to display the reconstructed surface.
The reconstructed workpiece is then displayed in the tool area, and the associated *.STL file is 
displayed in the scene.

Reconstructing/extracting a surface
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① Source file
② Result file
③ Reconstructed model
④ Navigation window with model

After finishing reconstruction, the wizard can be run backwards by pressing "Back". The 
reconstruction can be started again with changed parameters.

Error
If an error occurs, processing of the script is aborted. Possible causes could be:
• There is no active tool in the tool database. The error message shows the missing tool with 

the number. Enter the tool in the database and start the script again
• The spindle was not selected correctly.
• The correct signals were not selected for reconstruction.
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11.2.6 Assigning a tool

Tool IDs for surface reconstruction
For surface reconstruction using a script, you require the data of the tools used. Tool data are 
managed in the Tool ID Database.
You can use the Tool ID Database Editor to assign tools to an active ID and create tools that 
are not available in the collection. For the definition, you require the tools and their current 
data that are used in the machine.
The active tool ID is then used for surface reconstruction. 

Tool collection and tool assignment
In the tool collection, tools can be created with all the necessary data. In the tool assignment, 
they are then assigned to an active ID.
If no tool has been assigned to an active ID, an error message is displayed after the script has 
been processed. The message lists the IDs that are not assigned.

Adding a new tool
In order to add a new tool, proceed as follows:
1. Execute "Extension > Tool ID Database".

The editor of the Tool ID Database is displayed.
2. Click the tool collection into the foreground.
3. Click on "Add New".

Figure 11-5 Creating a new tool
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4. Enter the tool data and click on "Save Tool".
– ID: number for identifying the tool. To avoid confusion, it is recommended to use the 

Active Tool ID here (see below).
– Cone Angle: characteristic of the tool used
– Length: characteristic of the tool used
– Radius: characteristic of the tool used
– Type: type number of the tool (tool list in the tool management in SINUMERIK Operate)
– Description: text used to describe the tool in more detail

5. The tool is created using the entered data.
6. If you want to revise the data, right-click on the entry and execute "Edit" in the displayed 

dialog.
7. To delete the tool, right-click on the entry and execute "Remove" in the displayed dialog.

Registering a tool
To assign a tool to an active ID, proceed as follows:
1. Execute "Extension > Tool ID Database".

The Tool ID Database Editor is displayed.
2. Click tool assignment into the foreground.
3. Click on "Add New".

The "Tool Mapping" dialog opens.

Figure 11-6 Assigning a tool
4. Enter an active tool ID.
5. Under "Tool ID", select the ID corresponding to the tool. You can assign the ID during tool 

registration.
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6. Click on "Map Tool".
7. The tool then appears in the list of assigned tools.

Determining the Active Tool ID
You determine the Active Tool ID required for the tool identifier in the Events widget for the 
loaded model.
1. To do this, open the Events widget.
2. Open an HFBlockEvent. 

The parameters of the event are listed. You find the value under "Active Tool".

Figure 11-7 Active Tool ID

11.3 Surface extraction

Extraction
Surfaces can be extracted from point clouds using surface extraction. This can be used, for 
example, to check the surface quality. 
The extraction is a computationally intensive process and can be parameterized in the 
following dialog.
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Figure 11-8 Surface extraction

Selecting points
1. Select the points in the model for which you want to perform a surface extraction.

Scene selection
1. Select the scene that contains the model.
2. Select the model with which you want to perform the surface extraction. Extraction only 

works for models that contain usable points/data. Accordingly, a message is displayed in the 
footer of the dialog.

Parameter settings
1. In "Sample size", enter the number of points to be considered for the surface extraction of a 

point. These are the points in the immediate vicinity that are used to calculate the normals. 
The larger the value, the more accurate the extraction, but the more computationally 
intensive the execution.

2. Enter a value in "Volume dimension". Use this parameter to specify the i, j, and k dimensions 
to be applied to the distance function for surface extraction.

Surface extraction result
• Enter a name for the file under which the surface extraction is to be stored. The file is 

displayed in the scene and must be explicitly saved, otherwise the data will be lost when the 
scene is closed.
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① Model file used for the extraction.
② Temporarily generated surface extraction that can be saved.
③ Extracted model

Figure 11-9 Extracted surface

Reconstructing/extracting a surface
11.3 Surface extraction

Analyze MyWorkpiece /Toolpath
142 Operating Manual, 06/2023, A5E48913345B AH



Machine simulation 12
Simulating workpiece machining

The machine simulation simulates the tool movements required for the workpiece on the 
volumetric model. The workpiece is machined step by step.
For this purpose, the model is first imported and positioned.
Possible data types are:
• JSON
• XML
• CSV

Tools
The following tools are supported:

Tool type Description
110 Ball nose end mill
120 End mill

Machine simulation
The machine simulation is controlled via the "Machine simulator" dialog:
1. To start the machine simulation, run "Extensions > Machine simulation".
2. The "Machine simulator" dialog appears.
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Overview

① Dialog for controlling the simulation
② Display area of the model

Figure 12-1 Machine simulation - Overview

Machine simulation
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12.1 Performing a simulation

Defining simulation parameters
To perform a machine simulation, you need to set the following parameters:

① Set quality (4 levels)
② Select tool
③ X, Y, Z - minimum values for the bounding box
④ X, Y, Z - maximum values for the bounding box
⑤ Display of the grid size (voxel)
⑥ Switch off visualization of the simulation
⑦ Operate simulation

Figure 12-2 Machine simulation - Dialog

Quality of the simulated workpiece
The quality of the simulation can be adjusted via a slider, which thus determines the size of the 
volume units (voxels). Up to four quality levels are possible. The higher the set quality, the more 
complex the simulation calculation and the longer it takes to simulate the workpiece.
The voxel size is displayed under "Information".
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Tools
The tools are displayed in the "Tools" drop-down list:
1. Open the drop-down list.
2. Then select your tool.

Defining a bounding box
The bounding box defines the volume from which the workpiece is machined. The larger the 
box, the longer the simulation will take.
If only parts of the workpiece are of interest, the rest can be removed using the bounding 
box.

① Boundaries of the bounding box
② Origin of the workpiece coordinate system (0 point)

Figure 12-3 Bounding box

Changing the size of the bounding box
1. In the "Machine simulator editor" dialog, enter the new values for the bounding box in the 

respective fields.
- OR -

2. Use the arrow keys on the right edge of the input field.
– When entering minimum values, the X, Y and Z values become smaller or negative with 

respect to the origin. The boundaries of the box are moved down (-Z), forward (-Y), or to 
the left (-X).

– When entering maximum values, the X, Y and Z values become larger with respect to the 
origin. The boundaries are moved up (Z), backward (Y), or to the right (X).

Using the 4D function
If you made settings for the model in the 4D viewlet, e.g. the velocity distribution is to be 
displayed in color, then these settings (colors) are also displayed in the simulated model.
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Starting simulation
Once all parameters have been entered, the simulation can be started.

Note
Disable the option "Visualize during simulation" to save computing time.

1. Click on the "Start" button to start the simulation.
The progress of simulation is displayed in a progress bar and can be tracked in the working 
area.
- OR -

2. Click on the "Pause" button to pause the simulation.
- OR -

3. Click on the "Stop" button to stop the simulation.

Figure 12-4 Performing a simulation
After the end of the simulation, the model can be moved, enlarged, or reduced.

Note
It is not possible to save the simulation.
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Displaying log files 13
13.1 Displaying a log file

Log viewer
The log viewer displays messages relating to events in Analyze MyWorkpiece /Toolpath. The 
messages can be filtered and examined.
If messages are pending, the button in the footer starts flashing.

Click the button to open the log viewer.

The log viewer includes a toolbar with functions for filtering and examining messages. With 
multiple selections, the active filters are evaluated.

① Shows all information.
② Shows all alarms.
③ Shows all errors
④ Activates the text box for full text search
⑤ Text box for search term The display is immediately refreshed.
⑥ Opens the log file or allows log files to open.

In the table, the messages are specified by additional data, such as time, scene, model or file.
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Importing data from Analyze MyWorkpiece /
Capture 14
14.1 Users and certificates

14.1.1 Creating a new user

The next steps are only necessary if one of the "amwtoolpath" users assigned to the 
"amwtoolpath" group is not yet present on this device.

Requirement
You have already installed an Analyze MyWorkpiece /Capture client certificate. A description of 
this can be found in the "Analyze MyWorkpiece /Capture" Operating Manual.

Adding a user
Execute the following steps to create a user:
1. Open the Miniweb administrator dialog in your web browser.

At https://<ip_or_dnsname_of_your_edge_box>:5443.
2. Log in as administrator.
3. Navigate to "Security>User Manager".

4. Click "Add new user".
5. Enter the following data:

– Login: amwtoolpath
– Real name: optional, i.e. "AMW /Toolpath"
– Description: optional, i.e. "Analyze MyWorkpiece/Toolpath"
– Enter a password.
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6. Click "Add new user" to create the new user.
7. Select the newly created user "amwtoolpath" from the "User list", and click the "Add group" 

button.

8. Enter "amwtoolpath" as the group name. The entry is case-sensitive.

9. Click "Add group".
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10.Navigate to "Security>Certificate management".

11.Select "TrustedClients" from the "Certificate store" drop-down list.
12.Click "Create certificate in store".

13.Enter "amwtoolpath" in the "Common name" field, scroll down and click "Create certificate in 
store". The certificate is created and the dialog is closed.
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14.Select the newly created client certificate, and click "Export".

15.Ensure that the correct key is selected.

16.Enter a password for the export, and click the "Export" button.

14.1.2 Installing a client certificate
When installing the client certificate on your computer, the steps may differ depending on the 
operating system being used. The following steps have been tested with Windows 10:

Procedure
1. Right-click the downloaded certificate "amwtoolpath.p12".
2. Click "Install certificate" or "Install PFX".
3. Click "Current user > Next".
4. Click "Next".
5. Enter the password that was entered while generating the client certificate in the "Password:" 

field.
6. Click "Next".
7. Click "Place all certificates in the following store".
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8. Select the "Personal" folder and click "OK".
9. Click "Finish".

14.1.3 Creating a server certificate
The following steps may vary depending on the IT infrastructure. In this manual, it is assumed 
that the SINUMERIK Edge device can be accessed via a static IP address, and the server 
certificate is based on a self-signed certificate.

Procedure
1. Navigate to "Security>Certificate management".
2. Select "ServerCerts" from the "Certificate store" drop-down list.

If the stated certificate shows the IP address of the SINUMERIK Edge device under "Subject" 
and "Issuer", continue with step 5. Otherwise, select the listed certificate, and remove it by 
clicking "Delete".

3. Click "Create certificate in store", and enter the following data:
– Common name: Static IP address of this SINUMERIK Edge device 
– DNS name: Static IP address of this SINUMERIK Edge device
– File name: SSLServerCert

4. Click "Create certificate in store".
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5. Select the certificate from the list, and click "Export".
6. Click "Export" again. 

Note: "Export key" must not be selected.

7. Restart your SINUMERIK Edge.

14.1.4 Installing a certificate

Installing a server certificate
When installing the server certificate on your computer, the steps may differ depending on the 
operating system being used. The following steps have been tested with Windows 10:
1. Right-click the downloaded certificate "SSLServerCert.crt".
2. Click "Install certificate".
3. Click "Current user".
4. Click "Next".
5. Click "Place all certificates in the following store".
6. Select the "Trusted Root Certification Authorities" folder and click "OK".
7. Click "Finish".
8. Restart the program if Analyze MyWorkpiece /Toolpath was active during the installation.
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Installing a client certificate
1. Install the client authentication certificate (amwtoolpath.p12) in the dialog "Manage user 

certificates" (type "certmgr.msc" in the Windows search) in the personal memory area of the 
PC. 

2. Go through the steps of the installation wizard. 
A user-defined password is required for the client authentication certificate.

This is how to install the 'SIEMENS miniweb' certificate type https://<url>:5444/
capture in Internet Explorer:
1. At the end of the address bar, click on the icon "Safety report" (padlock), and in the pop-up 

dialog on the button "Show certificates". 
2. Click "Install certificate..." in the newly opened "Certificate" dialog, and go through the steps 

of the installation wizard. 
The certificate must be installed in the "Trusted Root Certification Authorities".

To install the 'SIEMENS miniweb' certificate, proceed as follows:
1. Enter https://<url>:5444/capture as address in the browser. 
2. At the end of the address bar, click on the icon "Safety report" (padlock), and in the pop-up 

dialog on the button "Show certificates". 
3. Click on "Install certificate..." in the newly opened "certificate" window and go through the 

steps of the installation wizard. 
The certificate must be installed in the "Trusted Root Certification Authorities".

SINUMERIK Edge can be configured such that an alias is used instead of the IP address. In this 
case, the alias must be defined in the file "%system32%-drivers-etc-hosts".

14.2 Establishing a connection to Edge
After recording data with Analyze MyWorkpiece /Capture, you can import them to Analyze 
MyWorkpiece Toolpath for evaluation.
When using the "External source > Import captured file(s) from Edge" function, it is assumed 
that the necessary MiniWeb HTTPS certificate is installed in the Trusted Root Certificate 
Authorities, and the client certificate is installed in the User Certificate Store. 

Note
Files in Analyze MyWorkpiece /Capture
The .zip files that were downloaded remain in the %App% directories of the user and are not 
deleted. If you download jobs with the same names, then the files are appropriately numbered, 
e.g. job_(1).zip, job_(2).zip... The data can be managed in the file manager.
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Establishing the connection
To start the import, a connection must first be established to a SINUMERIK Edge:
1. Execute "External source > Import captured file(s) from Edge" in Analyze MyWorkpiece /

Toolpath.
The dialog with the same name opens.

2. Click on "Use client certificate" to use the certificate you created as described in Users and 
certificates (Page 151).

3. Click on "Add New..." to add an Edge connection.
Analyze MyWorkpiece /Toolpath automatically searches for the appropriate version.

4. Enter the IP address of SINUMERIK Edge.
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5. Assign an alias name, under which the Edge connection is shown in the sideview. The IP 
address can also be assigned as an alias name.

Figure 14-1 Starting the import of SINUMERIK Edge

If certificate installation or IP address aliasing fails, an error message is shown in the "External 
source > Import captured file(s) from Edge" window.

6. Click "Test Connection" to check the validity of the inputs and establish a test connection.
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7. When you log in to Edge for the first time, you will be prompted for the username and 
password you assigned.

8. If you are already logged into Analyze MyWorkpiece /Capture, the username and password 
are already entered.
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Editing connections
Once you have established a connection, the alias names of all connections are displayed in the 
sideview. Proceed as follows to edit a connection:
1. Click on the entry in the sideview and run "Options".
2. The following options are shown:

– "Remove"; removes the data that has been entered.
– "Restore Changes"; redisplays the data that has been saved.
– "Save Changes"; saves the changes.
– "Test Connection"; checks the connection data via a test connection.
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14.3 Importing data

Loading the job to Analyze MyWorkpiece /Toolpath
As soon as a connection has been established to Edge, job data is transferred out of SINUMERIK 
Edge. A progress bar displays the transfer status. The list of jobs is displayed once all data has 
been transferred.
1. Select the required job.

Figure 14-2 Loading the job list
2. Click on "Next" to display the content of the job.

The jobs are displayed according to ascending recording time; the latest is at the beginning. 
The recording time is displayed at the end of the file name with date and time.
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Figure 14-3 Job content
3. Select the files that you wish to import.
4. Click "Next".

Figure 14-4 Selecting scene and module
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5. Select in which scene the file should be loaded:
– Into a new scene; AMWT creates a new scene, and imports the file into this scene
– Into individual scenes; the files are each loaded into a scene.
– Into an existing scene; the file is loaded into an existing scene.

6. Select how the file is to be imported into models:
– As different models; the file is split up into different models.
– As one model; the file is imported into one model.
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7. Click "Load".
If you have selected existing scenes, then you can select into which scene the file is loaded.

Figure 14-5 Selecting an existing scene
8. Select the scene and click on "Load".

The data is automatically loaded and saved without a password prompt. The password is 
generated automatically and is decoded by Analyze MyWorkpiece /Toolpath.

Figure 14-6 Importing a file from AMW /Capture
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14.4 Managing stored data

Transferring data from the Edge
The data transferred from the Edge to Analyze MyWorkpiece /Toolpath can only be opened 
there. The imported ZIP files are password-protected to prevent unauthorized access by other 
applications.

Figure 14-7 Manage stored data
You can use the dialog to load files and delete saved files.
The size of the file is displayed in the left column.

Changing the password
You change the password in the dialog of the same name.
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Figure 14-8 Changing the password
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Connecting Teamcenter 15
15.1 Teamcenter

By connecting to Teamcenter, you can access the data archived there. AMWT establishes a 
connection to Teamcenter.

Establishing a connection to Teamcenter
To connect to Teamcenter, you need the following information:
• IP address
• Port
• User name
• Password
To log on to Teamcenter via AMWT, proceed as follows:
1. Execute "External source > Teamcenter".

The "Analyze MyWorkpiece /Toolpath - TC" dialog opens.
2. Enter the following data:

– IP address: Enter the IP address of the Teamcenter server here.
– Port: Enter the port number here.
– User name: Enter your user name in Teamcenter here.
– Password: Enter your Teamcenter password here.

3. Click "Login".
AMWT establishes a connection to Teamcenter.
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Troubleshooting 16
16.1 Problems with the graphics card

Error description
Error occurs immediately after installation (during normal startup and when starting as 
administrator).

Figure 16-1 Error image 1
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Figure 16-2 Error image 2
The error occurs when zooming and moving the object (regardless of the file type stl, xml, 
mpf).
You have a computer with two graphics cards, as the following example shows:

Figure 16-3 Control panel - graphics card
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Troubleshooting
You can solve the problem by booting the system with the NVIDIA graphics chip:
1. Open the control panel of the graphics card by clicking on the icon of the graphics card in the 

taskbar, for example.

Figure 16-4 NVIDIA setting
1. Select "Manage 3D settings".
2. Under the "Program settings" tab, add Analyze MyWorkpiece /Toolpath as the program for 

which you want to use the 3D settings.
3. Select "High-performance NVIDIA processor" as the graphics processor.
4. Click "Apply".

Troubleshooting
16.1 Problems with the graphics card

Analyze MyWorkpiece /Toolpath
Operating Manual, 06/2023, A5E48913345B AH 173



Figure 16-5 Error resolved
Alternatively, you can also start Analyze MyWorkpiece /Toolpath via the shortcut menu (right-
click on the exe file) and select the high-performance processor there. However, this setting 
is not saved.

Figure 16-6 Opening with NVIDIA
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16.2 Connection between AMW /Capture and AMW /Toolpath

Connection problems
If you use AMW /Toolpath with AMW /Capture, a connection-related error may be displayed. The 
following table contains information on how to correct the specified error.

Error message Possible cause Remedy
     
WinHttpSendRequest: 12044: A certificate 
is required to complete client authentica‐
tion

The client authentication certificate is 
not imported into the user's personal 
certificate store.

Import the client authentication certifi‐
cate into the personal certificate store.

WinHttpSendRequest: 2148074277: The 
certificate chain was issued by an authori‐
ty that is not trusted

Although the client authentication cer‐
tificate is available, it is possible that the 
root certificate is missing from the Trus‐
ted Root Certification Authorities store.

Import the existing root certificate in the 
Trusted Root Certification Authorities 
store. It is recommended that you re‐
generate the root, server and client au‐
thentication certificates if the problem 
persists.

WinHttpSendRequest: 2148073488: Ac‐
cess denied.

An invalid password was specified or 
the password request session was ter‐
minated by the user.

Enter the correct password.

SSL Error: WINHTTP_CALLBACK_STA‐
TUS_FLAG_INVALID_CERT SSL certificate 
invalid.

A secure connection with AMW /
Capture cannot be established due to 
missing or invalid MiniWeb Server cer‐
tificates.

Make sure that the generated server cer‐
tificate is imported into the MiniWeb se‐
curity configuration page and the root 
certificate is imported into the Trusted 
Root Certification Authorities store on 
the client computer. It is recommended 
that you regenerate the root, server and 
client authentication certificates if the 
problem persists.

error calling getServerInfo: FORBIDDEN (1) An incorrect Edge platform version was 
selected.

Select the correct Edge platform ver‐
sion. 

SSL Error: WINHTTP_CALLBACK_STA‐
TUS_FLAG_CERT_REV_FAILED failed to 
check revocation status. WINHTTP_CALL‐
BACK_STATUS_FLAG_CERT_CN_INVALID 
SSL common name does not match.

The DNS name is used when connect‐
ing to AMW /Capture. Previously, the 
server certificate was configured using 
only the DNS name and not the IP ad‐
dress.

To connect to AMW /Capture, enter the 
IP address of the Edge device. If the DNS 
name must be used, the certificates 
must be regenerated with the correct 
configuration. We recommended that 
you check the system host file. Even with 
properly configured certificates, the 
host file must contain the DNS name - IP 
address assignment.

AMWT version < V2.5 Connection mechanism between Cap‐
ture and AMWT has been changed

Edge devices added to AMWT in a previ‐
ous AMWT version (for example, v2.4) 
can no longer connect due to the 
changes in the Toolpath Capture inte‐
gration.

Troubleshooting
16.2 Connection between AMW /Capture and AMW /Toolpath

Analyze MyWorkpiece /Toolpath
Operating Manual, 06/2023, A5E48913345B AH 175



Troubleshooting
16.2 Connection between AMW /Capture and AMW /Toolpath

Analyze MyWorkpiece /Toolpath
176 Operating Manual, 06/2023, A5E48913345B AH



Analyze MyWorkpiece /Toolpath - Python API 
Developer Guide A
A.1 Overview

This section describes and explains the fundamental concepts of extending the core 
functionality of Analyze MyWorkpiece /Toolpath based on user-defined Python scripts. 
This section guides you through the development techniques:
• Installation of the development environment
• Coding instructions based on examples
• Compilation and deployment

Function overview
Analyze MyWorkpiece /ToolPath runs precompiled Python scripts (*.pyd -files), which are saved 
in subfolder thirdparty\python_virtualenv of your Analyze MyWorkpiece /ToolPath 
installation folder. To run a script, run Extensions > Extension wizard in Analyze MyWorkpiece /
ToolPath. 
You can select the list of these files from the drop-down list "Script selection" of the extension 
wizard. 

A.2 Development environment - Installation

Installation
Download the Python 3.7.x environment from the official website:
https://www.python.org/downloads/release/python-379/
Install "Windows x86-64 executable installer" in a user-defined directory: e.g. 
c:\projects\Python37
Open a command line in the installation directory.
Create a virtual environment with Python 3.7:
python -m pip install virtualenv
python -m virtualenv venv
Start virtualenv:
cd venv 
.\Scripts\activate
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Copy the following content in a file from requirements.txt in folder (/venv):

Source code
Cython==0.29.21
joblib==1.1.0
llvmlite==0.38.0
numpy==1.21.5
pandas==1.3.5
plotly==5.6.0
python-dateutil==2.8.2
pytz==2022.1
scikit-learn==1.0.2
scipy==1.7.3six==1.16.0
sklearn==0.0
tenacity==8.0.1
threadpoolctl==3.1.0

Run the pip installation program:
python -m pip install -r requirements.txt

A.3 Use the Cython compiler
Analyze MyWorkpiece /Toolpath supports extension scripts, which are precompiled by Cython. 
Cython is an optimizing static compiler for the Python programming language, see
https://cython.org/ (https://cython.org/)
Any .py source files can be compiled as follows.
Create the cython_compile.py help file in directory venv/ with the following content:

Source code
# Copyright (C) Siemens AG 2019-2021. All rights reserved.
#!python
#cython: language_level=3

from setuptools import setup
from Cython.Build import cythonize
import glob
import os

def compile():
    file_list = glob.glob("*.py")
    for file in file_list:
        if file.endswith('cython_compile.py'):
            continue
        setup(
            ext_modules = cythonize(file)
        )

This script compiles (cythonizes) every file with py extension using the Cython compiler. 
Detailed information about the compilation process is provided under:
Cython user guide (https://cython.readthedocs.io/en/latest/src/userguide/
source_files_and_compilation.html)
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The next line is the compilation process itself. Generate the pyd file using the following 
command:
python.exe -c "from cython_compile import *;compile()" build_ext --
inplace
The generated *.pyd files must be copied to <AMWT_install directory 
dir>\thirdparty\python_virtualenv\.
After Analyze MyWorkpiece /ToolPath restarts, the new extension is available in the menu of 
the extension wizard via "Extensions > Extension wizard".

A.4 Storage location of Python extensions in the AMW /ToolPath 
The Python environment and the scripts are installed in the following folder: 
<AMW Toolpath>\thirdparty\python_virtualenv\  
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A.5 Python skeleton template code

Obligatory functions
This section describes the obligatory functions of a Python file.

Source code
import package
 
def version():
    # version required for handshaking
def checkParameters(parameters):
    # script specific parameter check
#
# main business logic is implemented in calculate function 
#
def calculate(params):
    # on error print a message and quit with exit code 1
    if error:
        print("Error message")
        sys.exit(1)
    # on success print a message and quit with exit code 0
    print("Work done")
    sys.exit(0)

def description():
    """
    Put your description here. Note the three quotation marks.
    """
    return None

def getParamTemplate():
    """
    Put your json formatted parameter definition here as described later in this document. 
Note the three quotation marks.
    """
    return None

def manual_test():
    # you may want to invoke the script outside of AMW Toolpath. This is the entry point

if __name__=="__main__":
    manual_test()

Every script has its own description, which is displayed by AMW /Toolpath.
In general, "Exit-Code 1" refers to an error, and "Exit-Code 0" to normal execution. 
Analyze MyWorkpiece /Toolpath captures and displays everything that you print in the 
standard output.
The business logic must be implemented in the calculate() function. The requested 
parameters are defined using JSON data. These are subsequently described, so that each 
script can define its own List Manual.
You can perform a validation, as the parameters are dynamic and specific for the actual 
Python script. 
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Call sequence
The call sequence that is executed in Analyze MyWorkpiece /Toolpath is shown in the following 
graph.

A.6 Examples

A.6.1 Visualizing signals and calculating higher order derivations
This Python test source code shows an algorithm that processes an input signal. It can read a 
specified signal from a predefined trace file (xml, csv, zip, json), and calculate the first, second 
and third derivations (velocity, acceleration and jerk).

A.6.2 Obligatory functions
You must specify the following functions to be able to communicate with the GUI:

Function name Description
version() version() must return a character string with the 

version code of the API; current version 1.0. The 
graphic ToolPath user interfaces uses scripts, 
where the version information matches.

description() The textual description of the actual function must 
be specified in the comment format in triple excla‐
mation marks (""").

getParamTemplate() This function returns definitions of input parame‐
ters in the Python dictionary format. 

calculate() Calculates results, generates files and returns val‐
ues.
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A.6.3 Parameter template format
JSON format to describe input and output data. The following complex example illustrates the 
use.

Source code
{
  "inputs": [
    {
      "inputFiles": "Choose one or more trace filenames|multipleInputFiles",
      "signals": [
        "Select signals|multipleSignals",
      ]
    },
    {
      "inputFiles": "Choose a trace filename|singleInputFile",
      "signals": [
        "Select X position signal|singleSignal",
        "Select Y position signal|singleSignal",
        "Select Z position signal|singleSignal",
      ]
    }
  ],
  "params": {
      "num_clusters": "Number of Clusters||3",
      "metrics": "Metrics Type|l1#l2#euclidean#manhattan|l2"
  },
  "outputs": {
      "resultFileName": "result.bin",
      "resultImageName": "image.png"
  }
}

Code Description
inputFiles Input prompt and definition separated by |.

Definition can be multipleInputFiles or singleInputFile.
signals Array, signal input 0 or more. Every input element has an input prompt and a 

definition, which are separated by |
Definition can be multipleSignals or singleInputFile.

params Defines the parameters required by the script as "parameter_name": "Defini‐
tion" 
Definition is a character string separated with "|" with the following data:
"Input prompt | Data set | Default value", where "Data set" can be empty or 
comprise individual values separated with "#".

outputs Defines the output generated by the script as "Definition": "File name"
"Definition" can be resultFileName, which generates binary data, 
or resultImageName, which generates an image file that should be dis‐
played or autogeneratedOutputFile|. ext, with which Analyze My‐
Workpiece /Toolpath can generate a file name with the specified extension.
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A.6.3.1 Special parameters
You can specify hidden parameters, which are not displayed in the parameter setting dialog, as 
shown in the following example: 

Source code
"params": {
          "requiresToolDatabase|Tool data required|true#false|true",
          "exportSignalData|hidden 1||input/signals.bin",
          "useLoadedModelsOnly|hidden 2||true"
          }

Note
For more than one "hidden" parameter, use a unique number to make a differentiation between 
them.

Code Example
requiresToolDatabase If the setting is "true", then a tool database is transferred in the JSON 

format.
exportSignalData The case of a surface reconstruction, the selected signals are exported 

to a temporary binary file.
useLoadedModelsOnly With this parameter, the user can only use loaded models.

Note
Prompt is only a descriptive text; there is no validation. This means that if you use "Select X 
position signal" there is no validation; you can transfer any signal.
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A.6.3.2 Python code - Example 1

Example 1
Source code
import sys
import json
from fileFormatUtils import load_data

# returns version information
def version():
    return '1.0'

#
# checks input parameter template, in case of errors call: sys.exit(1)
# error messages print to standard output
#
def checkParameters(parameters):
    # missing ‘inputs’ attribute
    if "inputs" not in parameters:
        print("No inputs specified")
        sys.exit(1)
    
    inputs = parameters["inputs"][0]
    
    # missing ‘inputFiles’ argument 
    if "inputFiles" not in inputs:        
        print("No input file specified")
        sys.exit(1)
    
    # missing ‘signals’ argument
    if "signals" not in inputs:        
        print("No signals specified")
        sys.exit(1)

    signals = inputs["signals"]        
    
    # we can use only one signal in this example
    if len(signals) != 1:
        print("Only one signal must be specified")
        sys.exit(1)
    
    if "params" not in parameters:
        print("No 'params' in parameters.")
        sys.exit(1)
        
    params = parameters["params"]
    
    # this section guarantees that we are using all 
    # the three input parameters and one output parameter required
    if "fig_size_X" not in params:
        print("Missing parameter: Figure Size X")
        sys.exit(1)

    if "fig_size_Y" not in params:
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Source code
        print("Missing parameter: Figure Size Y")
        sys.exit(1)
    
    if "outputs" not in parameters:
        print("No 'outputs' in parameters.")
        sys.exit(1)
    
    if not parameters["outputs"]["resultFileName"].endswith('.html'):
        print("Output file extension must be .html")
        sys.exit(1)        
    
    return

#
# main business logic
#
def calculate(params):
    # convert input string to JSON object
    parameters = json.loads(params)
    # check input parameters
    checkParameters(parameters)
    
    # obtain filename from the input JSON
    inputs = parameters["inputs"][0]
    inputFile = inputs["inputFiles"]
    signals = inputs["signals"]
    
    # load data automatically with a file reader
    df = load_data(inputFile, signals)
    
    if df is None:
        print("Unable to read input file")
        sys.exit(1)

    import scipy.signal as signal
    import matplotlib.pylab as plt
    import matplotlib
    import numpy as np
    
    # 
    # create output signal names: velocity, acceleration and jerk
    # apply signal filtering
    # 
    velocity_column_name = signals[0] + ' VELOCITY'
    
    # Apply a Savitzky-Golay filter to an array and differentiate 
    df[velocity_column_name] = np.gradient(signal.savgol_filter(df[signals[0]], 41, 1), 1)
    
    acceleration_column_name = signals[0] + ' ACCELERATION'
    df[acceleration_column_name] = np.gradient(df[velocity_column_name], 1)
    
    jerk_column_name = signals[0] + ' JERK'
    df[jerk_column_name] = np.gradient(df[acceleration_column_name], 1)
    
    # create a Figure
    f, ax = plt.subplots(nrows=len(df.columns), ncols=1, 
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Source code
                     figsize=(parameters["params"]["fig_size_X"], parameters["params"]
["fig_size_Y"]), 
                     subplotpars=matplotlib.figure.SubplotParams(hspace=0.2, wspace=3))
    
    # draw signals one by one
    for i in range(len(df.columns)):
        ax[i].plot(df[df.columns[i]])
        ax[i].margins(x=0, y=0.25)
        ax[i].set_ylabel(df.columns[i], fontsize=10, rotation=0)
        ax[i].yaxis.set_label_coords(-0.1, 0.5)
        ax[i].set_xticklabels([])

    # create a plotly offline plot and render results in a html file
    import plotly
    import plotly.tools as tls
    fig = tls.mpl_to_plotly(f)
    plotly.offline.plot(fig, filename = parameters["outputs"]["resultFileName"], 
auto_open=False)

    # open the default browser to show result
    import os    
    # open html in the default browser
    os.startfile(parameters["outputs"]["resultFileName"])
    sys.exit(0)

def description():
    """
    Calculate velocity and acceleration of a selected signal - Using Savitzky-Golay 
filtering.
    """
    return None

def getParamTemplate():
    """
    {
      "inputs": [
        {
          "inputFiles": "Choose a trace filename|singleInputFile",
          "signals": [
            "Select signals|oneSignal"
          ]
        }
      ],
      "params": [
          "fig_size_X|Figure X size||20",
          "fig_size_Y|Figure Y size||10"
      ],
      "outputs": {
          "resultFileName": "|autoGeneratedOutputFile|.html"
      }
    }
    """
    return None

def manual_test():
    return calculate("""
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Source code
                     {
                      "inputs": [
                        {
                          "inputFiles": "x:/Testrack_Apple_HF.5.json",
                          "signals": [
                            "DES_POS|1"
                          ]
                        }
                      ],
                      "params": {
                          "fig_size_X": "20",
                          "fig_size_Y": "10"
                      },
                      "outputs": {
                          "resultFileName": "results/out.html"
                      }
                    }
                    """)

A.6.3.3 Python code - Example 2

Example 2
The following example calculates the vector length of three scalar signals (axes). The result is an 
array, which is returned to Analyze MyWorkpiece /ToolPath. 

Note
The manual_test() function allows developers to run this script outside of Analyze 
MyWorkpiece /ToolPath. (the Python environment and the required components should be 
installed)
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Source code
import sys
import json
from fileFormatUtils import load_data, make_full_path

def version():
    return '2.0'

def checkParameters(parameters):
    if "inputs" not in parameters:
        print("No inputs specified")
        sys.exit(1)
    
    if len(parameters["inputs"]) != 1:
        print("Number of inputs must be one")
        sys.exit(1)        
    
    for inputs in parameters["inputs"]:
        if "inputFiles" not in inputs:        
            print("No input file specified")
            sys.exit(1)
        
        if "signals" not in inputs:        
            print("No signals specified")
            sys.exit(1)

        signals = inputs["signals"]        
        
        if len(signals) != 3:
            print("Number of signals must be 3")
            sys.exit(1)
    
    if "params" not in parameters:
        print("No 'params' in parameters.")
        sys.exit(1)
    
    if "outputs" not in parameters:
        print("No 'outputs' in parameters.")
        sys.exit(1)
    
    if not parameters["outputs"]["resultFileName"].endswith('.bin'):
        print("Output file extension must be .bin")
        sys.exit(1)        
    
    return

def calculate(params):
    # convert string parameters into JSON
    parameters = json.loads(params)
    # check input syntax
    checkParameters(parameters)
    
    input = parameters["inputs"][0]
    inputFile = input["inputFiles"]
    signals = input["signals"]
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Source code
    # load input
    df1 = load_data(inputFile, signals)
    
    # check errors
    if df1 is None:
        print('Error: inputfile cannot be loaded: ', inputFile)
        sys.exit(1)    
    
    result = df1
    
    # calculate euclidean distance
    result['Vector length'] = (df1[signals[0]] ** 2 + df1[signals[1]] ** 2 + df1[signals[2]] 
** 2) ** 0.5 
    import numpy
    # write result into a file
    # file data will be displayed in AMWT Toolpath
    result_array = numpy.array(result['Vector length'])
    
    # result file has absolute path? if not then add current absolute path
    resultFile = make_full_path(parameters["outputs"]["resultFileName"])
    result_array.astype("float32").tofile(resultFile)
    
    # normal exit without errors
    sys.exit(0)

def description():
    """
    This script calculates Euclidean distance of three signals in one input trace file.
    It is usefull when you want to analyse e.g. 'CONTROL DIFF' signals.
    """
    return None

def getParamTemplate():
    """
    {
      "inputs": [
            {
          "inputFiles": "Choose first trace filename|singleInputFile",
          "signals": [
            "Controll Diff X Axis|CTRL_DIFF|singleSignal",
            "Controll Diff Y Axis|CTRL_DIFF|singleSignal",
            "Controll Diff Z Axis|CTRL_DIFF|singleSignal"
          ]
        }  
    ],
      "params": [
      ],
      "outputs": {
          "resultFileName": "Choose an output binary file|singleOutputFile|.bin"
      }
    }
    """
    return None

def manual_test():
    return calculate("""
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Source code
    {
      "inputs": [
            {
          "inputFiles": "tests/Testrack_HF.5_trace.json",
          "signals": [
            "CTRL_DIFF|1",
            "CTRL_DIFF|2",
            "CTRL_DIFF|3"
          ]
        } 
    ],
      "params": {
      },
      "outputs": {
          "resultFileName": "results/out.bin"
      }
    }
    """)

if __name__=="__main__": 
    manual_test()

A.6.4 Format of parameter template V2

Overview
Using Python script parameter template format 2.0, the behavior of /Toolpath Python extension 
can be extended at the front end. This extended script implementation acts on object "params" 
of the function content getParamTemplate(). The structure is based on JSON and the parent-
child relationship.
The 2.0 script can modify the user interface corresponding to the implementation of the Python 
script; further, predefined validation functions ensure that the value of the specified parameter 
object satisfies the necessary requirements.
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Source code
def getParamTemplate():
    """
    {
      "inputs": [
        {
          …
        }
      ],
      "params": [
        {
           "<Object-name>": { Name of the created object in /Toolpath
              "UI-Type": "<ui-tpye>", Type of the parameter object (see more in Supported 
Parameter Types)
              "Display-Name": "<display-name>", This name is displayed on the ui next to the 
corresponding ui object
              "Max-Width": "<max-width>", Maximum width of the given parameter object
              "Max-Height": "<max-height>", Maximum height of the given parameter object
              "Parameter-ID": "<parameter-id>", Id of the parameter. This id is used by the 
python script when executing it
              "Default-Value": "<default-value>", Initial default value of the parameter 
object
              "Values": [ List of possible parameter values.
                 "<value1>",
                 "<value2>",
                 "<value3>",
                 "<value4>"
              ],
              "Child-Objects": [ List of additional parameter objects 
              ]
           }
         }
     ],
      "outputs": {
          …
      }
    }
    """
    return None

A.6.4.1 Parameter types

Supported parameter types
Depending on the defined UI type the specified parameter object can be displayed or hidden, can 
be interactive or static.
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UI type "Group"
A group field can be created with the specified properties. A group field can contain additional 
parameter objects.

Source code
"Group_Object": {
            "UI-Type": "Group",
            "Display-Name": "Parameter Group",
            "Max-Width": "250",
            "Max-Height": "300",
            "Child-Objects": [
               ...
            ]
}

UI type "Input"
A text input field is created. The default value is required. Validation and value change functions 
can be added.

Source code
"Input_Object": {
        "UI-Type": "Input",
        "Display-Name": "Parameter Input:",
        "Max-Width": "150",
        "Parameter-ID": "param_id",
        "Default-Value": "10",
        "Function": "Function_1"
}

UI type "Combo Box"
A combo box is created. Default values and optional values are required. Validation and value 
change functions can be added.

Source code
"Combobox_Object" : {
        "UI-Type": "Combobox",
        "Display-Name": "Parameter combo:",
        "Max-Width": "150",
        "Parameter-ID": "param_id",
        "Default-Value": "value3",
        "Values": [
            "value1",
            "value2",
            "value3",
            "value4"
        ],
        "Function": " Function_1"
}
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UI type "None"
Invisible parameter object. Its value cannot be changed via the user interface.

Source code
"Nonvisible_object": {
    "UI-Type": "None",
    "Parameter-ID": "param_id",
    "Default-Value": "value1"
}

A.6.4.2 Validation

Pre-defined validation functions
Predefined validation functions can be attached to parameter objects to ensure that the actual 
parameter value is correct. These functions can only be attached to parameter objects, type 
Input and Combo box, and they are executed each time the value changes.
If the specified parameter value does not comply with the necessary requirements that 
are defined by the attached validation function, then you cannot continue with the script 
configuration in the Python-extension of Analyze MyWorkpiece /Toolpath.
• Validator_IsNumeric: Checks whether the specified parameter value is numerical.
• Validator_IsFloat: Checks whether the specified parameter value is a "float" value
• Validator_IsVector3D: Checks whether the specified parameter value defines a 3D vector. 

Each value is separated by a blank (e.g.: 10.6 24.3 0.4)

Source code
"Input_with_validation": {
                "UI-Type": "Input",
                "Display-Name": "Parameter with validation:",
                "Max-Width": "150",
                "Parameter-ID": "input_validation",
                "Default-Value": "30",
                "Validation": "Validator_IsNumeric"
}
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A.6.4.3 Parameter template - example

Program example
Source code
def getParamTemplate():
    """
    {
      "inputs": [
        {
          "inputFiles": "Choose a trace filename|singleInputFile",
          "signals": [
            "Select signals|multipleSignals"
          ]
        }
      ],
      "params": [
        {
          "1_Group": {
            "UI-Type": "Group",
            "Display-Name": "Parameter-Group-1",
            "Child-Objects": [
              {
                "1_Parameter": {
                  "UI-Type": "Combobox",
                  "Display-Name": "Parameter 1:",
                  "Max-Width": "150",
                  "Parameter-ID": "1_Parameter",
                  "Default-Value": "val3",
                  "Values": [
                    "val1",
                    "val2",
                    "val3",
                    "val4"
                   ]
                },
                "2_Parameter": {
                  "UI-Type": "Combobox",
                  "Display-Name": "Parameter 2:",
                  "Max-Width": "150",
                  "Parameter-ID": "2_Parameter",
                  "Default-Value": "val3",
                  "Values": [
                    "val1",
                    "val2",
                    "val3",
                    "val4"
                   ]
                },
                "1_Sub_Group": {
                  "UI-Type": "Group",
                  "Display-Name": "Sub-Parameter-Group-1",
                  "Child-Objects": [
                    {
                      "1_Sub-Parameter": {
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Source code
                        "UI-Type": "Combobox",
                        "Display-Name": "Sub-Parameter 1:",
                        "Max-Width": "150",
                        "Parameter-ID": "1_Sub-Parameter",
                        "Default-Value": "val3",
                        "Values": [
                          "val1",
                          "val2",
                          "val3",
                          "val4"
                        ]
                      },
                      "2_Sub-Parameter": {
                        "UI-Type": "Input",
                        "Display-Name": "Sub-Parameter 2:",
                        "Max-Width": "150",
                        "Parameter-ID": "2_Sub-Parameter",
                        "Default-Value": "val"
                      },
                      "3_Sub-Parameter": {
                        "UI-Type": "Input",
                        "Display-Name": "Sub-Parameter 3:",
                        "Max-Width": "150",
                        "Parameter-ID": "3_Sub-Parameter",
                        "Default-Value": "val"
                      }
                    }
                  ]
                },
                "2_Sub_Group ": {
                  "UI-Type": "Group",
                  "Display-Name": "Sub-Parameter-Group-2",
                  "Child-Objects": [
                    {
                      "4_Sub-Parameter": {
                        "UI-Type": "Combobox",
                        "Display-Name": "Sub-Parameter 1:",
                        "Max-Width": "150",
                        "Parameter-ID": "4_Sub-Parameter",
                        "Default-Value": "val3",
                        "Values": [
                          "val1",
                          "val2",
                          "val3",
                          "val4"
                        ]
                      },
                      "5_Sub-Parameter": {
                        "UI-Type": "Input",
                        "Display-Name": "Sub-Parameter 2:",
                        "Max-Width": "150",
                        "Parameter-ID": "5_Sub-Parameter",
                        "Default-Value": "val"
                      },
                      "6_Sub-Parameter": {
                        "UI-Type": "Input",
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Source code
                        "Display-Name": "Sub-Parameter 3:",
                        "Max-Width": "150",
                        "Parameter-ID": "6_Sub-Parameter",
                        "Default-Value": "val"
                      }
                    }
                  ]
                }
              }
            ]
          },
          "2_Group ": {
            "UI-Type": "Group",
            "Display-Name": "Parameter-Group-2",
            "Child-Objects": [
              {
                "3_Parameter": {
                  "UI-Type": "Input",
                  "Display-Name": "Parameter 3:",
                  "Max-Width": "150",
                  "Parameter-ID": "3_input",
                  "Default-Value": "10"
                },
                "4_Parameter": {
                  "UI-Type": "Input",
                  "Display-Name": "Parameter 4:",
                  "Max-Width": "150",
                  "Parameter-ID": "4_input",
                  "Default-Value": "10"
                },
                "5_Parameter": {
                  "UI-Type": "Combobox",
                  "Display-Name": "Parameter 5:",
                  "Max-Width": "150",
                  "Parameter-ID": "5_input",
                  "Default-Value": "val3",
                  "Values": [
                    "val1",
                    "val2",
                    "val3",
                    "val4"
                  ]
                }
              }
            ]
          }
        }
      ],
      "outputs": {
          
      }
    }
    """
    return None
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Result in Analyze MyWorkpiece /Toolpath
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